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4

Using the powerful and wide-ranging 
controls in the Adobe Camera Raw plug-in, 
you can apply corrections to your photos 
before opening them into Photoshop. In this 
comprehensive chapter, you’ll learn about the Camera 
Raw tools and tabs; choose workflow options for  
Camera Raw; apply cropping and straightening; and 
correct photos for defects, such as poor contrast, under- 
or overexposure, color casts, blurriness, geometric distor-
tion, and noise. You will also learn how to enhance your 
photos with special effects, such as a vignette, grain 
texture, or tint; retouch blemishes; access Camera Raw 
controls from Photoshop; save and synchronize Camera 
Raw settings among related photos; then finally, open 
your corrected photos into Photoshop.

Note: The Camera Raw plug-in, which we refer to simply 
as “Camera Raw,” is included with Photoshop. Some 
users also refer to the plug-in as “ACR,” short for Adobe 
Camera Raw.

Why use Camera Raw?
Amateur-level digital cameras store images in the JPEG 
or TIFF format, whereas advanced amateur and pro 
models offer the option to save images as raw data files, 
which offers substantial advantages. Cameras apply 
internal processing to photos that are captured as JPEG 
or TIFF, such as sharpening, automatic color adjustments, 
and a white balance setting. With raw files, you get only 
the original raw information that the lens captured onto 
the camera’s digital sensor, leaving you with full control 
over subsequent image processing and correction.

These are some basic facts about Camera Raw:

➤➤ Camera Raw can process raw, TIFF, and JPEG photos 
from most digital camera models.

➤➤ Camera Raw offers powerful controls for correcting 
problems in your photos, such as over- and under-
exposure and color casts, and for applying enhance-
ments, such as a vignette or a grain texture.

➤➤ Camera Raw saves edits to TIFF and JPEG files in 
the file itself, whereas edits to raw files are saved 
as instructions (in a separate “sidecar” file or in the 
Camera Raw database). When you open a photo 
from Camera Raw into Photoshop, the instructions 
are applied to a copy of the file, and the original raw 
file is preserved.

➤➤ To any image layer in Photoshop, you can apply 
some Camera Raw features via the Filter > Camera 
Raw Filter command.
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CAPTURING TONAL VALUES: YOUR CAMERA VERSUS THE HUMAN EYE

A The digital sensor in a camera captures tonal values 
in a linear fashion, from light to dark, without altering 
the incoming data. A light value of 50% is located at the 
midpoint of the tonal range.

50% light value

B Camera Raw redistributes some of the captured tonal 
values to the shadows and midtones, shifting the 50% 
light value past the midpoint. As a result, the lower tonal 
values — the range the human eye tends to be more 
sensitive to — contain more data.

50% light value

More reasons to use Camera Raw
In case you’re not fully sold on the benefits of cor-
recting your digital photos in Camera Raw before 
opening them into Photoshop, consider these points: 

Ability to preview raw files: The only way to preview 
a raw photo is in Camera Raw (or other software that 
converts raw files). Note: The photo that you view 
on the LCD screen of your digital camera is merely a 
JPEG preview of the raw capture, not the “actual” raw 
capture.

Great correction features: Camera Raw offers many 
unique adjustment controls that you simply won’t 
find in Photoshop. 

Less destructive edits: When applying corrections to 
a photo, the goal is to preserve as much of the image 
quality as possible. Adjustments that you make to a 
photo in Camera Raw (and that are applied automat-
ically when the photo is opened in Photoshop) cause 
less data loss than similar adjustment commands in 
Photoshop. 

Preserves 16 bits per channel: To preserve more of 
the original pixel data in a raw photo, Camera Raw 
keeps the bit depth as 16 bits per channel. This helps 
offset the data loss from subsequent image edits in 
Photoshop, and results in a better-quality photo.

Tonal redistribution: The sensor in a digital camera 
captures and records the existing range of tonal 
values in a scene as is, in a linear fashion, without 
skewing the data toward a particular tonal range.A 
That sounds fine on paper, but the reality is that the 
human eye is more sensitive to lower light levels 

than to higher light levels. In other words, we’re  
more likely to notice if shadow areas lack detail and 
less likely to notice extra details in highlight areas. 
The result is that digital photos typically contain 
more data than necessary for the highlight values in 
a scene and insufficient data for the lower midtone 
and shadow values. In a Camera Raw conversion, 
data is shifted more into the midtone and shadow 
ranges of your photo. This not only helps compen-
sate for the peculiarities of human vision, but also 
helps prepare your photos for subsequent image 
edits in Photoshop.B If you apply tonal adjustments 
in Photoshop to a photo that contains insufficient 
shadow data, the result is posterization and a notice-
able loss of detail; if you apply the same edits to 
a good-quality photo that has been converted in 
Camera Raw, the destructive edits will be far less 
noticeable.

Superior noise reduction and sharpening: Not 
to knock Photoshop, but the noise reduction and 
sharpening features in Camera Raw cause less data 
loss than similar features in Photoshop.

Learning the Camera Raw features will give you a 
head start: The tonal and color controls in Camera 
Raw are similar to many of the adjustment con-
trols in Photoshop (e.g., Levels, Curves, and Hue/
Saturation) that are discussed in later chapters. As 
you proceed through the lessons in this book, you 
will apply and build on the skills you have mastered 
in this chapter. 
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Raw, JPEG, or TIFF?
Unfortunately, Camera Raw can’t correct deficiencies 
in digital JPEG and TIFF photos as fully as it can in 
raw photos, for several reasons. First, cameras reduce 
digital JPEG and TIFF photos to a bit depth of 8 bits 
per channel, and in so doing discard some of the 
captured pixels. Cameras save raw photos at a bit 
depth of 16 bits per channel, and preserve all the 
captured pixels. 

Second, cameras apply color and tonal corrections 
to JPEGs and TIFFs (called “in-camera” processing). 
Camera Raw must reinterpret this processed data, 
with less successful results than when it has access 
to the raw, unprocessed data. 

All of the above notwithstanding, if your camera 
doesn’t shoot raw photos or you acquire JPEG or TIFF 
photos from other sources, you can still use practi-
cally all of the outstanding correction and adjust-
ment features in Camera Raw to process them. 

Note: In this chapter, we focus only on processing 
raw and JPEG files in Camera Raw — not TIFF files. 
The JPEG format is mentioned only when a particular 
feature treats a JPEG differently than a raw file.

➤➤ Factoid: Each digital camera manufacturer cre-
ates its own version of a raw file and attaches a 
different extension to the names of its raw files, 
such as .nef for Nikon and .crw or .cr2 for Canon.

JPEG …
JPEG advantages

➤➤ JPEG files have a smaller storage size than raw 
files, so your digital camera can store more of them. 

➤➤ In sports, nature, and other fast-action photog-
raphy, speed is a necessity. Photo sequences can 
be captured more rapidly as JPEG files (due to their 
smaller storage size) than as raw files. 

➤➤ Most software programs can read JPEG files, but 
only a few programs can read raw files.

JPEG drawbacks
➤➤ The JPEG format discards some captured pixels 

due to its lower bit depth of 8 bits per channel.

➤➤ The JPEG compression methods destroy some 
image data and can produce defects, such as arti-
facts, banding, and loss of detail. 

➤➤ The pixel data in JPEG photos is processed inter-
nally by the camera. Although Camera Raw can be 
used to improve your JPEG photos, it won’t have 
access to the original pixel data (nor will you).

… COMPARED TO RAW
Raw advantages

➤➤ The raw compression methods are nondestructive. 

➤➤ Raw files have a higher bit depth of 16 bits per 
channel.

➤➤ Raw files contain the original, unprocessed pixel 
data and full range of tonal levels that were cap-
tured by the camera. Camera Raw is given all that 
image data to work with, and the result is a higher-
quality image — even after adjustments.

➤➤ Because the white point setting isn’t applied to 
your raw photo (it’s merely stored in the metadata 
of the file), you can adjust that setting at any time in 
Camera Raw. 

➤➤ Camera Raw does a better job of redistributing 
tonal values in raw files than in JPEG files, making 
raw files better candidates for Photoshop edits.

Raw drawbacks
➤➤ Raw files have larger storage sizes than JPEG files.

➤➤ Digital cameras create and store raw files more 
slowly than JPEG files, a potential drawback in 
fast-action photography (although as camera tech-
nology improves, this may become less of an issue).

The bottom line
Despite the faster speed and smaller storage sizes of 
JPEG files, raw files have more advantages.

KEEPING CAMERA RAW UP TO DATE ★
The easiest way to ensure that you are using 
the latest version of Camera Raw is to click the 
Creative Cloud icon  on your taskbar/menu 
bar, click Apps, then click any Update that is 
posted for Photoshop CC (2015) or Bridge CC.
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RECOGNIZING THE BADGE
In Bridge, the thumbnail for a file that has been 
opened and edited previously in Camera Raw will 
display this badge    in the upper-right corner, and 
the thumbnail and preview will reflect the current 
settings. Another clue: If the currently selected file 
has been edited in Camera Raw, you will see a Camera 
Raw category in the Metadata panel.

Opening photos into Camera Raw
For a smooth workflow, we recommend setting the 
proper preferences so your raw photos (and JPEG or  
TIFF photos, if any) will open directly into Camera Raw.

To set a preference so your raw photos 
open directly into Camera Raw:
1.	 In Photoshop, go to Edit/Photoshop CC > 

Preferences (Ctrl-K/Cmd-K) > File Handling. 

2.	 Under File Compatibility, check Prefer Adobe 
Camera Raw for Supported Raw Files, then click 
OK. When you double-click a raw file, it will open 
into Camera Raw (as opposed to other software 
that can be used to convert raw files).

To set a preference so your JPEG or TIFF 
photos open directly into Camera Raw:
1.	 In Bridge, choose Edit/Adobe Bridge CC > Camera 

Raw Preferences. 

2.	 At the bottom of the dialog, from the JPEG menu, 
choose Automatically Open JPEGs with Settings.

3.	 If you shoot digital TIFF photos, from the TIFF 
menu, choose Automatically Open TIFFs with 
Settings; or if you shoot only raw or JPEG photos 
(not TIFF photos), choose Disable TIFF Support.

4.	 Click OK. 

	 When you want to open a JPEG or TIFF photo into 
Camera Raw that has not yet been edited (doesn’t 
have Camera Raw settings), click the thumbnail 
in Bridge, then click the Open in Camera Raw 
button    or press Ctrl-R/Cmd-R. 

	 To open a JPEG or TIFF photo that has been 
edited previously in Camera Raw (that is “with 
Settings”), double-click its thumbnail or press 
Ctrl-R/Cmd-R.

➤➤ If you enable both “Automatically Open” options 
(steps 2–3, above), but there is an occasion when 
you want to open a JPEG or TIFF photo directly 
into Photoshop instead of Camera Raw, click the 
thumbnail, then press Ctrl-O/Cmd-O. This shortcut 
will work only if the file hasn’t yet been edited in 
Camera Raw.

➤➤ If the Open in Camera Raw button  is available 
when you click a thumbnail in Bridge, it’s a sign 
that the file can be opened into Camera Raw.

You can set a preference to have either Bridge or 
Photoshop host the Camera Raw plug-in when you 
open a raw or JPEG photo. In the case of Photoshop, 
the program will launch, if it’s not already running. 
Also, when Bridge is the host for Camera Raw, the 
default (highlighted) button for exiting that dialog 
is labeled Done, whereas when Photoshop is the 
host for Camera Raw, the default exit button is Open 
Image or Open Object, depending on a setting in the 
Workflow Options dialog (see step 10 on page 56).

To choose a host for Camera Raw:
1.	 In Bridge, choose Edit/Adobe Bridge CC >  

Preferences (Ctrl-K/Cmd-K), then show the 
General pane.

2.	 Check Double-Click Edits Camera Raw Settings 
in Bridge if you want Camera Raw to be hosted 
by Bridge when you double-click a thumbnail in 
Bridge (a raw photo or a JPEG that was previously 
edited in Camera Raw), or uncheck this option to 
have the file open into Camera Raw hosted by 
Photoshop. Click OK.
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After setting the necessary preferences, and before 
learning the particulars of Camera Raw, you should 
familiarize yourself with this basic workflow.

To open a raw or JPEG digital photo into 
Camera Raw:
1.	 Launch Bridge, display the thumbnail for a raw or 

JPEG photo, then do either of the following:

	 For a raw photo, double-click the thumbnail. 

	 For a raw or JPEG photo, click the thumbnail, then 
press Ctrl-R/Cmd-R or click the Open in Camera 
Raw button on the Bridge toolbar    (or right-
click the photo and choose Open in Camera Raw).

2.	 The Camera Raw dialog opens.A An alert 
symbol    may display in the upper-right corner 
of the preview while Camera Raw reads in the 
image data, and will disappear when it’s done. 

	 Information about your photo (taken from the 
metadata that was embedded into it by the 
camera) is listed in several locations: the camera 

model in the title bar at the top of the dialog; the 
file name below the preview; and the camera set-
tings used to take the photo (aperture, shutter 
speed, ISO, and focal length) below the histogram.

	 The adjustment features are located in 10 
tabs: Basic, Tone Curve, Detail, HSL/Grayscale, 
Split Toning, Lens Corrections, Effects, Camera 
Calibration, Presets, and Snapshots. Switch among 
the tabs to correct your photo (we cover most  
of the tabs in depth in this chapter).

3.	 When you’re done correcting the photo, you can 
either click Open Image to open the photo into 
Photoshop or click Done to close Camera Raw 
without opening the photo. In either case, the 
Camera Raw settings will stick to the photo, and 
the original data will be preserved. (Note: If you 
want to open the photo into Photoshop as a 
Smart Object, see the Note on page 95.)

➤➤ The Camera Raw preview and interface supports 
high-DPI displays.★

A The Camera Raw dialog

Link to the Workflow Options dialog (see pages 56–58)

The original 
camera 
settings

Tabs (click to 
access settings)

Toolbox Toggle Full Screen Mode/previous dialog size (F)

Histogram

Camera Raw 
Settings menu

Zoom controls Preview controls

You can right-click the 
background area, then 
use the context menu to 
change the background 
shade, or add/delete the 
hairline border.
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A file that you open from Camera Raw into Photoshop 
as a Smart Object can be reedited using the full array 
of features in Camera Raw at any time. A standard 
image layer in a Photoshop document can also be 
edited using most — but not all — of the Camera  
Raw features by way of the Camera Raw Filter, as 
described in the task below. If you convert the image 
layer to a Smart Object first (an optional step), you  
will be able to edit the filter settings at any time.  
Note: To learn about layers, which are used in this task, 
see Chapter 8. To learn more about Smart Objects, see 
pages 272–283. See also the first Note on page 95.

Among the Camera Raw features that aren’t avail-
able via the Camera Raw Filter are the Crop and 
Straighten tools, the rotate buttons, the Workflow 
Options dialog, the Snapshots tab, and some options 
on the Camera Raw Settings menu. Don’t be dissuaded 
by this list of “nos,” however — the filter gives you 
access to the essential Camera Raw features.

To open and edit a Photoshop image layer 
in Camera Raw:
1.	 In an RGB document in Photoshop, display the 

Layers panel.   Click the image layer (or the 
Background) that you want to edit in Camera Raw, 
then press Ctrl-J/Cmd-J to duplicate it. Keep the 
duplicate layer selected.A

2.	 Optional (but recommended): To keep your Camera 
Raw settings editable, choose Filter > Convert for 
Smart Filters, or right-click the duplicate image 
layer and choose Convert to Smart Object.B If an 
alert dialog appears, click OK. 

3.	 With the image layer or Smart Object selected, 
choose Filter > Camera Raw Filter (Ctrl-Shift-A/
Cmd-Shift-A).

4.	 The image layer opens in Camera Raw. Apply the 
needed corrections. 

5.	 Click OK (a progress bar may display while the 
filter is processing). 

6.	 If you applied the filter to a Smart Object, on the 
Layers panel, you will see a Camera Raw Filter 
listing below a Smart Filters listing.C To edit the 
Camera Raw settings at any time, double-click 
the Camera Raw Filter listing. To learn more about 
Smart Filters, see pages 374–378.

➤➤ To create a document via the Merge to HDR Pro 
command, and adjust the new document via the 
Camera Raw Filter, see pages 254–258.

CAMERA RAW FILTER OR PHOTOSHOP?
Although we sing the praises of Camera Raw in the 
first two pages of this chapter and strongly recom-
mend using it as a first step before opening a photo 
into Photoshop, Photoshop is no slouch when it 
comes to adjustment options. In fact, Photoshop has 
some commands and features that you won’t find in 
Camera Raw, such as adjustment layers. You can eas-
ily hide, show, clip, or restack any adjustment layer; 
edit its layer mask; and change its opacity or blending 
mode (see Chapter 12). Fortunately, you don’t have to 
decide between Camera Raw and Photoshop — you 
can use both!

A We duplicated 
an image layer.

B We converted 
the duplicate layer 
to a Smart Object.

C We applied the 
Camera Raw Filter  
to the Smart Object. 
A Smart Filters listing 
appeared below the 
Smart Object.
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The Camera Raw tools A
In the upper-left corner of the dialog, click the Zoom 
tool,   then click the image preview to zoom in or 
Alt-click/Option-click it to zoom out. Or right-click 
with the Zoom tool on the preview, check Scrubby 
Zoom on the context menu, then drag to the right to 
zoom in or to the left to zoom out.★
Use the Hand tool    to move a magnified preview 
image in the window (if another tool is selected, hold 
down the Spacebar for a temporary Hand tool).

For the White Balance tool,   see the sidebar on 
page 60.

Choose the Color Sampler tool,   then click in the 
image preview to place up to nine samplers. A break-
down of the RGB components below each sampler 
in the photo displays in a readout below the toolbox; 
the readouts will update as you make color and tonal 
adjustments. To reposition a sampler, drag it with the 
Color Sampler tool. To remove a sampler, hold down 
Alt/Option and click it. To remove all samplers, click 
Clear Samplers.

For the Targeted Adjustment tool  (or TAT for 
short),  see pages 66–67 and 71.

For the Crop tool,   see page 54.

For the Straighten tool,   see page 55.

For the Spot Removal tool,   see pages 90–91.

The Red Eye Removal tool  works like the  
Red Eye tool in Photoshop (see page 317).

For the Adjustment Brush tool,   see pages 72–76.

For the Graduated Filter tool,   see pages 86–87.

For the Radial Filter tool,   see pages 88–89.

Note: If tool settings are displaying on the right side 
of the Camera Raw dialog (if, say, you were using the 
Adjustment Brush tool) and you want to redisplay 
the row of tab icons, click one of the first seven tools.

➤➤ The tools in Camera Raw are “memory-loaded,” 
meaning that you can toggle them. Press a tool 
shortcut to select a different tool, then press the 
same key again to return to the original tool.

Other buttons at the top of the dialog:

➤➤ The Open Preferences Dialog button  (or 
press Ctrl-K/Cmd-K) opens the Camera Raw 
Preferences dialog.

➤➤ The Rotate 90° Counterclockwise  button   
and the Rotate 90° Clockwise button  rotate 
the image. The results preview in the dialog.

MORE WAYS TO ZOOM IN THE PREVIEW
➤➤ Hold down Alt/Option-Spacebar and click to 

zoom out, or hold down Ctrl/Cmd-Spacebar and 
click to zoom in.

➤➤ Press Ctrl –/Cmd – (hyphen) to zoom out or 
Ctrl- +/Cmd- + to zoom in.

➤➤ Use the zoom buttons (– or +) or the Zoom 
Level menu, located below the image preview.

➤➤ Double-click the Zoom tool to set the zoom 
level to 100%.

➤➤ Double-click the Hand tool to fit the image in 
the preview window.

A The shortcuts for the Camera Raw tools are listed in boldface above.

Z Zoom: 
Reduces or 
magnifies 
the preview

H Hand: Moves a 
magnified preview 
in the window

I White 
Balance: Sets 
the white 
balance

S Color Sampler:
Places up to nine  
RGB color sampler 
points in the preview

C Crop: Crops 
the photo based  
on a marquee 
you drag

A Straighten:
Straightens the 
photo along a  
line you drag

B Spot 
Removal: 
Heals 
imperfections

E Red Eye 
Removal: Corrects  
red-eye in a 
portrait photo

T Targeted 
Adjustment:   
Applies adjust-
ments where 
you drag in  
the preview

Graduated Filter G and 
Radial Filter J tools:  Apply 
edits gradually across an 
area that you designate

Opens the 
Camera Raw 
Preferences 
dialog

K Adjustment  
Brush: Applies 
local edits to 
areas you have 
masked

L Rotates  
the image 
90° counter- 
clockwise

R Rotates the 
image 90° 
clockwise 
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Cropping and straightening 
photos
With the Crop and Straighten tools, you can control 
which portion of a photo opens into Photoshop. You 
can readjust the crop box at any time without losing 
any image data, and the outlying areas will remain 
available even after you click Save, Done, or Open.

To crop a photo:
1.	 Open a photo into Camera Raw A (see step 1 on 

page 51). 

2.	 Choose the Crop tool  (C).

3.	 Drag in the preview to make a crop box appear.B
4.	 Optional: To move the crop box, drag inside it.  

To resize the box, drag a handle.

5.	 To preview the results of the Crop tool, press 
Enter/Return or click any tool except the Crop or 
Straighten tool.C

➤➤ To redisplay the current crop box after exiting 
crop mode, click the Crop tool. If you want to 
remove the box and redisplay the whole image, 
press Esc.

B With the Crop tool, we drew a crop box in the preview 
window. Here, we are resizing the box.

C We pressed Enter/Return to preview the results.

A This is the original photo, in Camera Raw.
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To straighten a crooked photo 
automatically:
1.	 Open a photo into Camera Raw, then double-

click the Straighten tool  (A); or choose the 
Straighten tool, then double-click anywhere in 
the image.

2.	 Press Enter/Return.

➤➤ To turn the Crop tool into a temporary 
Straighten tool, hold down Ctrl/Cmd.

To straighten a crooked photo manually:
1.	 Open a photo into Camera Raw, then choose the 

Straighten tool  (A).

2.	 Drag along an edge in the photo that you want 
to align to the horizontal or vertical axis.A A crop 
box will display, aligned to the angle you drew.B 

3.	 To preview the straighten results, press Enter/
Return.C 

➤➤ To change the straighten results after exiting 
crop mode, choose the Straighten tool (A), then 
drag again. 

➤➤ If you want to remove the crop box, choose the 
Crop tool (C), then press Esc.

B A crop box displays. C We pressed Enter/Return to preview the results.

A With the Straighten tool, we are dragging along 
an edge that we want to align to the vertical axis.
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Choosing default workflow options
Via the Workflow Options dialog, you can resize or 
sharpen a photo, or change its color space or bit 
depth, before opening it into Photoshop — the origi-
nal raw or JPEG file isn’t altered. Note that the choices 
that you make in this dialog become the new default 
settings, so they apply not only to the current photo, 
but also to subsequent photos that you open into 
Camera Raw. The dialog contains new Color Space and 
Preset options (see this page and the next), as well as 
Image Sizing options (see page 58). 

To choose settings in the Workflow 
Options dialog:
1.	 Open a photo into Camera Raw, then below the 

large image preview, click the underlined link. The 
Workflow Options dialog opens (A, next page).

2.	 If you want to apply a user-saved preset, choose it 
from the Preset menu (B, next page). Next, either 
click OK to exit the dialog, or choose custom 
options, as in the remaining steps.

3.	 From the Space menu, choose a color profile to 
be used for converting the raw file to RGB: Adobe 
RGB (1998), ColorMatch RGB, ProPhoto RGB, or 
sRGB IEC61966-2.1 (or “sRGB,” for short). The menu 
also lists preset RGB and CMYK output profiles 
for printers and displays, as well as any other 
profiles that you have installed in your system. In 
Chapter 1, you assigned Adobe RGB (1998) as the 
default color space for color management, so for 
optimal color consistency, we recommend also 
choosing that option here.

4.	 The Intent options control how colors will change 
in a photo when it is converted to the chosen pro-
file. If you chose any profile from the Space menu 
except one of the first five, from the Intent menu, 
choose Perceptual or Relative. If your photos 
tend to contain many colors that are outside the 
gamut of the chosen color space, Perceptual is the 
best choice because it attempts to preserve the 
appearance of colors as it shifts them into gamut. 
If your photos contain few colors that are out of 
gamut, Relative is the best choice, as it preserves 
more of the original colors. Your photo will display 
as a soft proof (a simulation of print output from 
your target device).

5.	 To control the amount of color and tonal informa-
tion in your photos, from the Depth menu, choose 
8 Bits/Channel or 16 Bits/Channel. If you choose 

16 Bits/Channel, more of the original capture 
information will be preserved in your photos as 
you edit them in Photoshop, but they will also 
have a larger file size and will require a large 
hard disk and a fast system with a lot of RAM for 
processing (see page 17). 

 6.	 If you chose a printer profile, check Simulate 
Paper & Ink to preview the photo using the range 
of black values that can be produced by that 
printer, on a simulation of white printing paper.

 7.	 In a standard workflow, you can keep Resize to 
Fit unchecked. If, on the other hand, you need to 
resize the current photo and other photos that 
you open into Camera Raw, keep the dialog open 
after step 12, and follow the task on page 58.

 8.	 Camera Raw applies a Resolution of 300 ppi to all 
photos as they are opened into Photoshop.  
If needed, you can choose a different value here.

 9.	 Optional: Use options under Output Sharpening 
to apply predefined sharpening. Check Sharpen 
For, then from the Sharpen For menu, choose an 
output medium of Screen, Glossy Paper, or Matte 
Paper; and from the Amount menu, choose the 
desired level of sharpening (Standard is a good 
all-purpose choice). 

➤➤ The sharpening values that Camera Raw 
applies via this dialog aren’t listed anywhere. 
If you want to control specific values when 
sharpening, uncheck Sharpen For and use the 
sliders in the Detail tab (see pages 68–69).

10.	The Open in Photoshop as Smart Objects option 
converts the Open Image button in the main 
Camera Raw dialog to an Open Object button, 
which opens your photo into Photoshop as a 
Smart Object. 

➤➤ If you leave this workflow option unchecked, 
you can convert the Open Image button to 
Open Object in the main Camera Raw dialog 
(for any photo) by holding down Shift. Learn 
about Smart Objects on pages 272–283.

11.	Optional: To save your current, custom Workflow 
Options settings as a preset that can be applied 
to any photo, from the Preset menu, choose New 
Workflow Preset. Enter a descriptive name for the 
preset, then click OK.
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12.	Optional: If you chose a preset and then changed 
any of the settings in the dialog, the word “(edited)” 
is now listed in the preset name. If you want to 
permanently update the current preset with 
your new custom settings, from the Preset menu, 
choose Update [preset name].

13.	Click OK. Your chosen workflow settings will be 
applied to the current photo and to all photos that 
you subsequently open into Camera Raw.

➤➤ To rename a user-saved Workflow Options preset, 
from the Preset menu in the dialog, choose the 
preset to be renamed, choose Rename [preset 
name], type the desired name, then click OK.

A Via the Workflow Options dialog, you can choose Preset, 
Color Space, Image Sizing, and Output Sharpening settings for 
the current and future photos. 

B From the Preset menu in the Workflow Options dialog, you can choose a user-saved workflow preset.

USING THE GAMUT WARNING BUTTON IN THE 
CAMERA RAW HISTOGRAM
If you choose a printer profile from the Space menu 
in the Workflow Options dialog, instead of two clip-
ping warning buttons on the histogram in the main 
Camera Raw dialog, you will see just one Gamut 
Warning button  (O). When this button is acti-
vated, areas of the photo that are outside the gamut 
of the chosen output device will display as red in 
the preview. If you need to bring those errant colors 
back into gamut, you can use either the Vibrance 
slider in the Basic tab or the Saturation sliders in the 
HSL/Grayscale tab.

QUICK AND EASY WAY TO APPLY A  
WORKFLOW OPTIONS PRESET
To apply a Workflow Options preset to a photo, 
instead of opening the Workflow Options dialog, 
right-click the link below the preview in the main 
Camera Raw dialog and choose a preset name from 
the context menu.
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If you need to resize multiple photos according to a 
specific criterion, such as the dimension of a long or 
short side of one of the photos, use the Resize to Fit 
feature in the Workflow Options dialog. If you don’t 
require the original high-megapixel count of your 
photos for image editing or output, shrinking them 
is an acceptable option. Enlarging photos, on the 
other hand, should be done only when necessary, as 
it diminishes their quality (preferably, don‘t enlarge 
your photos by more than 25% or 30%). 

Note: To resize or change the resolution of an indi-
vidual photo for a particular output medium, instead 
of using the options dialog in Camera Raw, we rec-
ommend using the Image Size dialog in Photoshop 
after you exit Camera Raw (see pages 138–141). The 
latter offers many image resizing options, including 
choices for resampling, with a document preview. 

To resize images via the Workflow 
Options dialog: 
1.	 Open one or more photos into Camera Raw, then 

click the Workflow Options link. Under Image 
Sizing, check Resize to Fit.

2.	 Optional: Check Don’t Enlarge if you want to 
prevent your photos from being enlarged.

3.	 Under Image Sizing, from the Resize to Fit 
menu,A do one of the following (Camera Raw 
will resize all your photos proportionately, 
whether or not you enter proportionate values):

	 Choose Width & Height, then enter the desired 
maximum W and H values within which the cur-
rent and future photos will be resized. For resiz-
ing to occur, both of these values must be either 
larger or smaller than the original dimensions of 
the current photo.

	 Choose Dimensions,B then enter the desired 
maximum values in the two fields within which 
Camera Raw will resize your photos. Camera Raw 
will fit the longer dimension of each photo to the 
larger of the two values (regardless of the orien-
tation of the photo). You could use this option to 
resize a series of horizontal or vertical photos to 
the same long dimension.

➤➤ If the Width & Height or Dimensions option 
produces unexpected resizing results in 
your photos, try entering the same value in 
both fields, thereby providing a larger resiz-
ing area, or use the Long Side or Short Side 
option instead (see the next option).

	 Choose Long Side or Short Side, then enter the 
desired value for that dimension.

	 Choose Megapixels, then enter the desired total 
pixel count value. All photos will be resized to 
that value.

	 Choose Percentage, then enter a percentage by 
which you want your photos to be resized (pref-
erably, less than 130%, and not more).

➤➤ When you use the Resize to Fit option, the 
new dimensions and megapixel (MP) count 
are listed in the right side of the Image Sizing 
area. If you want to learn the original dimen-
sions of the current photo, uncheck Resize to 
Fit; the original dimensions will display in the 
dimmed W and H fields; now recheck the box.

4.	 Click OK. Note: Because the current settings in 
the Workflow Options dialog are applied to all 
photos that you open into Camera Raw, after 
using the dialog to resize the desired photos, exit 
Camera Raw. Upon reopening Camera Raw, be 
sure to open the Workflow Options dialog and 
uncheck Resize to Fit.

A From the Resize to Fit menu in the Workflow Options dialog, 
choose a criterion for resizing your photos.

B If you choose Dimensions as the Resize to Fit option, you 
must then enter pixel values in the two fields below the menu.
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The Camera Raw tabs
To access a panel of related settings in Camera Raw, 
click one of the tab icons (shown above). We perform 
most of our work in the first four tabs, and recom-
mend that you do the same. Use the other tabs for 
specialty corrections or enhancements, as needed.

Basic: Adjust the white balance and exposure (see 
pages 61–65).

Tone Curve: Fine-tune a specific tonal range, such as 
the upper or lower midtones (see pages 66–67).

Detail: Apply capture sharpening and reduce 
unwanted noise (see pages 68–69).

HSL/Grayscale: Adjust the hue, saturation, and lumi-
nance of individual colors (see pages 70–71).

Split Toning: Apply one color tint to the highlight 
areas of a photo and a second tint to the shadow 
areas (see page 77).

Lens Corrections: Correct a photo for the effects of 
lens distortion, such as geometric distortion (e.g., a 
building that is tilted backward or isn’t level), under- 
or overexposure at the edges (an unwanted vignette), 
chromatic aberration, and color fringes.

Effects: As a special effect, apply a grain texture, a 
vignette, or a dehaze correction (see pages 82–85).

Camera Calibration: The Process menu in this tab lets 
you update a file to the latest Camera Raw processing 
(see the sidebar on the next page). If the profile that 
Camera Raw provides for your camera model doesn’t 
produce satisfactory color results, use the sliders in 
this tab to tweak the settings manually.

Presets: Create a custom preset of the current Camera 
Raw settings for future application to any other 
photos (see page 92).

Snapshots: For flexibility in editing, save interim 
versions of a photo as you make corrections. When 
necessary, you can restore the photo to any snapshot 
version (see the sidebar on page 92).

If you find a need to undo or reset your slider settings 
as you work in Camera Raw, you can use any of the 
methods below. (To learn about related options on 
the Camera Raw Settings menu, see the next page.)

To restore default settings to sliders in 
the Camera Raw tabs:
	 Do any of the following:

	 Double-click a slider to reset it to its default value 
(usually 0).

	 Shift-double-click a slider in the Basic tab to reset 
it to the Auto value.

	 Click Default in the Basic or HSL/Grayscale tab to 
reset all the sliders in just that tab to 0.

	 Hold down Alt/Option and click Reset at the 
bottom of the dialog (Cancel becomes Reset) to 
restore the settings, in all tabs, that were in effect 
when you opened the dialog.

Basic Detail Split Toning Effects

Tone Curve

Camera Calibration

HSL/Grayscale Presets Snapshots
Lens 

Corrections

Using the Camera Raw tabs

USING THE PREVIEW BUTTONS
From the Before/After Views menu  below the pre-
view, choose a preview option. For instance, Before/
After Left/Right displays the original photo on the left 
(or displays the photo with the settings that were cop-
ied to the button, see below), and the photo with the 
current Camera Raw settings on the right. Before/After 
Top/Bottom Split displays the two versions in top and 
bottom halves of one image. Or if you prefer to cycle 
through the menu settings, click (and keep clicking) 
the Before/After Views button  (Q). To customize the 
views, choose Preview Preferences from the menu.

➤➤ To swap the positions of the previews, click the 
Swap Before/After Settings button  (P).

➤➤ To save the current Camera Raw settings as the 
Before state of the image, click the Copy Current 
Settings to Before button  (Alt-P/Option-P). There-
after, when you choose a Before/After view, those set-
tings will display in the top or left part of the preview.

USING THE SCRUBBIES
To change a value quickly in a Camera Raw 
tab, instead of dragging a slider, drag to the 
left or right across the slider name (this is 
called a scrubby slider).
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When you open a photo into Camera Raw, by default, 
it’s adjusted according to the built-in profile for  
your camera model, and all the sliders in the Basic  
tab are set to 0. At any time, you can assign a differ-
ent collection of settings to your file, or restore the 
original settings. 

To restore settings via the Camera Raw 
Settings menu:
	 From the Camera Raw Settings menu,   choose 

one of these options: A
	 Image Settings to restore the settings that were 

attached to the file during the initial photo shoot 
or, if the photo was previously edited in Camera 
Raw, from the last Camera Raw session. When a 
photo is opened for the first time into Camera 
Raw, these settings will match the Camera Raw 
Defaults settings.

	 Camera Raw Defaults to remove all custom set-
tings and reapply the default settings for your 
camera model, your specific camera, or the ISO 
setting that was used to take the photo.

	 Previous Conversion to apply the settings from 
the prior image that was adjusted in Camera Raw.

	 Custom Settings to reapply the custom settings 
that you have chosen since opening the photo 
into Camera Raw.

	 If a user-saved preset is applied to the current 
photo, that preset will also be listed as an option 
on this menu (see page 92).

UPDATING LEGACY PHOTOS AND THE  
CAMERA RAW SLIDERS
When you bring an unprocessed photo into Camera 
Raw 9.x, the dialog uses its most up-to-date profiles 
for noise reduction, de-mosaicing, sharpening, color 
calibration, and other processing. If you want to 
update a raw photo that was already processed in 
Camera Raw 6 or earlier using the new profiles, and 
also update the sliders in the Basic and other tabs to 
the newest versions (as described in this chapter), 
before applying any custom adjustments, click the 
Update to Current Process (2012)  icon at the bot-
tom right of the preview window. The Process menu 
in the Camera Calibration tab  changes to the set-
ting of 2012 (Current). Note: If you want to preserve 
access to the older rendering of the photo, take a 
snapshot of it before you update it (see the sidebar 
on page 92).

SETTING THE WHITE BALANCE
The color temperature of the lighting in which a 
photo is shot, whether natural or artificial, influences 
the relative amounts of red, green, and blue that are 
recorded by the camera. A digital camera attempts 
to balance the three colors to produce an accurate 
white, which in turn makes other colors in the photo 
more accurate; this is called the “white balance.” 

There are a few ways to adjust the white balance 
of a photo in Camera Raw. Note: Before adjusting 
the white balance, make sure your display is prop-
erly calibrated.

➤➤ Our recommended method is to drag the 
Temperature and Tint sliders in the Basic tab, choos-
ing settings based on how the photo looks to your 
eye (see the next page).

➤➤ For photos that are shot in controlled lighting, 
such as in a studio, another method is to use the 
White Balance tool  (I). Drag (don‘t click) to define 
a rectangle on a medium to light gray area of the 
photo — if you can find one. Camera Raw will set the 
White Balance based on pixel values in the sampled 
area. Note that although the White Balance tool is 
improved, sampling a larger area of “nearly gray” 
pixels than before, the resulting color temperature 
and tint correction may still not be adequate, and 
may need further adjustment.

➤➤ Here’s an iffy, but quick, method: Shift-double-
click the Temperature slider, and Shift-double-click 
the Tint slider. Camera Raw will apply auto settings 
for those controls.

A Use options on the Camera Raw Settings menu to restore 
default settings to your photo or to reapply the prior settings.

TOGGLING THE DEFAULT SETTINGS FOR A TAB
To quickly toggle between any custom settings 
made via the current tab only and the Camera Raw 
Default settings for that tab, click the rightmost but-
ton below the preview  (Ctrl-Alt-P/Cmd-Option-P). 
If the photo is displayed in a divided preview, the 
default settings will display in just the “After” section.
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C A Temperature value of 5500 strikes a good balance 
between warm and cool.

B We lowered the Temperature value too much. Now the 
photo looks too cool (has a bluish cast).

A When a photo is opened for the first time into Camera 
Raw, the White Balance menu in the Basic tab is set to As 
Shot. This photo has a high Temperature value and looks  
too warm (yellowish).

Using the Basic tab
As its name implies, the Basic tab contains the most 
essential correction features of Camera Raw — and it 
displays first, by default, when you open the dialog. 
We have divided the use of this tab into several tasks, 
beginning with setting the White Balance, on this page, 
then proceeding through exposure, contrast, and satu-
ration adjustments, on pages 62–65. 

To apply white balance adjustments via 
the Basic tab:
1.	 With a photo open in Camera Raw, click the Basic 

tab.   A If the whole photo isn’t visible in the pre-
view, double-click the Hand tool    in the toolbox.

2.	 Do either of the following:

	 From the White Balance menu, choose a preset 
that best describes the lighting conditions in 
which the photo was taken, such as Daylight or 
Shade. (Choose As Shot, if needed, to restore the 
original camera settings. Note that only As Shot 
and Custom are available for JPEG and TIFF files.)

	 Lower the Temperature value to add blue and 
make the image look cooler,B or raise it to add 
yellow and make the image look warmer.C To fine-
tune the temperature correction, move the Tint 
slider slightly to the left to add a bit of green or 
to the right to add magenta. (The White Balance 
menu setting changes to Custom, to indicate that 
you have chosen manual settings.)
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On the histogram in the Camera Raw dialog, the red, 
green, and blue areas represent the three color chan-
nels in a photo, and the white areas represent the 
areas where those three colors overlap. Clipping, the 
shifting of tonal values to absolute black or white in 
a photo, occurs if the tonal range of a scene is wider 
than the range that can be captured by the camera. 
You can tell that pixels are clipped in a photo if the 
vertical bars are primarily clustered in taller peaks at 
one or both ends of the histogram (shadow pixels 
on the left, highlight pixels on the right). You can also 
drag in the histogram to apply tonal adjustments.

As you make slider adjustments in Camera Raw, 
your goal is to bring the pixels into the range of your 
chosen RGB color space and minimize clipping. When 
tonal values are redistributed, the histogram updates 
accordingly. Note: Remember, we recommended that 
you choose Adobe RGB as the color space both for 
your camera (see page 5) and for photos that you 
open into Camera Raw (see page 56). 

To turn on the histogram clipping 
warnings for the preview:
	 In the top-left corner of the histogram, click the 

Shadow Clipping Warning button (U);A clipped 
shadows display in the preview as blue. In the top-
right corner, click the Highlight Clipping Warning 
button (O); clipped highlights display in the pre-
view as red. (When a button is activated, it has a 
white border.)

In the two tasks that follow this one, we show you how 
to use a number of sliders in the Basic tab. Once you 
learn the function of the sliders, remember that you 
can also make adjustments by dragging in the histo-
gram, as described here.

To make tonal edits via the histogram:
1.	 In Camera Raw, display the Basic tab,   then roll 

over the histogram.A As you move the pointer, 
one of five vertical gray drag zones will appear. 
The drag zone, as well as the data in the info area 
below the histogram, corresponds to one of these 
five sliders: Blacks, Shadows, Exposure, Highlights, 
or Whites.

2.	 Drag horizontally in a drag zone to adjust that 
tonal range; the corresponding slider will shift 
accordingly.B

Instructions continue on page 64

B When we positioned our pointer within the drag 
zone for the Shadows range in the histogram, then 
dragged horizontally, the corresponding Shadows 
slider in the Basic tab shifted accordingly.

Use the middle batch of sliders in the Basic tab to 
apply tonal corrections to your photo, preferably in 
the order listed in the dialog (there’s a logic to their 
sequence). At first, all the sliders are set to 0 and the 
underlined word “Default” is dimmed. 

To apply exposure and contrast 
adjustments via the Basic tab:
1.	 Turn on the Clipping Warning buttons.

2.	 Use the Exposure slider to lighten or darken the 
entire photo, as needed.

3.	 Use the Contrast slider to increase or reduce the 
color intensity and tonal contrast (A–B, next page).

A When we rolled over an area of the histogram, a 
drag zone appeared, and the corresponding Basic 
slider name and setting appeared in the info area.

Shadow Clipping 
Warning button

Highlight Clipping 
Warning button
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B Our first goal is to lighten the overall photo and recover details in the midtones 
and shadows without washing out the highlights. In the Basic tab, we increased 
the Exposure value,* then increased the Contrast value to intensify the highlights, 
shadows, and color saturation. We’re not concerned that the photo is still too dark, 
as it can be lightened with further adjustments.

*We chose an Exposure value of +0.60 for the raw version of this photo. If you are working with the JPEG version that we have 
supplied for downloading, use an Exposure value of +0.80 instead.

A This original photo was underexposed (too dark), causing the colors to look dull. The blue 
warning color in the preview indicates the shadow areas in the photo that are clipped. 
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A We reduced the Highlights 
value to recover details in the sky 
and increased the Shadows value 
to recover details in the shadows 
and lower midtones. The colors 
and detail in the midtones, and the 
overall balance of lights and darks, 
are improved. However, reducing 
the Highlights value caused the 
white areas to look dull.

4.	 If you increased the contrast, the highlights and 
shadows probably now need to be adjusted:

	 To restore details in the highlights, move the 
Highlights slider to the left until only a smidgen 
remains of the red highlight warning color.

	 To restore details in the shadows, move the 
Shadows slider to the right until only a smidgen 
remains of the blue shadow warning color.A Or 
if you need to darken the shadows, move this 
slider to the left.

5.	 Now that details have been restored to the mid-
tones and highlights, you’re ready to adjust the 
whites and blacks:

	 Increase the Whites value to brighten the white 
areas in the photo. This slider also has the effect 
of lightening the upper midtones and brighten-
ing the colors.

	 Use the Blacks slider to lighten or darken the 
black areas (A, next page). This slider may also 
affect the color brightness.

➤➤ If the colors are now washed out as a result 
of your increasing the Whites or Blacks value, 
you could try increasing the Contrast value.

➤➤ To further adjust the tonal values in the 
midtones, see pages 66–67.

➤➤ To have Camera Raw set the Whites or Blacks 
value automatically, hold down Shift while 
double-clicking one of those sliders.

REMOVE CLIPPING IN THRESHOLD PREVIEW
To remove shadow clipping a different way, Alt-drag/ 
Option-drag the Shadows or Blacks slider. A Threshold 
preview displays (as shown below). Release the mouse 
when small amounts of color or black display in the 
white preview. 

You can also Alt-drag/Option-drag the Exposure, 
Highlights, or Whites slider to display a Threshold 
preview for that adjustment. Release the mouse when 
only a smidgen of white displays in the black preview.
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A We increased the Whites value 
to lighten the upper midtones  
and brighten the whites, and 
increased the Blacks value to 
recover more details in the shad-
ows. Overall, the brightness, as well 
as the colors, are much improved.

B Finally, we increased the Clarity 
value slightly to sharpen the 
details and increased the Vibrance 
value slightly to boost the color 
saturation (note the change 
on the car body). Our cumula-
tive adjustments to this photo 
improved the contrast, clarified 
the details, and produced richer 
color. Vroom, vroom!

To apply edge contrast and color saturation adjustments using the Basic tab:
1.	 To add depth by intensifying the edge contrast in 

the midtones, increase the Clarity value; or for a 
deliberate soft-focus effect (such as in a portrait or 
landscape), reduce the Clarity value.

2.	 Change the Vibrance value to adjust the color 
saturation.B

3.	 Turn off both clipping warnings by pressing U, 
then O. 

➤➤ We recommend using the Vibrance slider instead 
of the Saturation slider to adjust color saturation 
because the former is less likely to cause oversatu-
ration (and it protects skin tones), whereas the 
latter is more likely to cause oversaturation and 
highlight clipping. To view the effect of this, drag 
the Saturation slider to the far right.
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Using the Tone Curve tab 
After using the Basic tab, a next logical step is to 
make a more refined adjustment of the upper  
and lower midtones, which we recommend doing 
individually via the Parametric sliders in the Tone 
Curve tab.

Note: We avoid manipulating the curve in the 
nested Point tab, because a misshapen curve can 
cause a photo to look posterized. The sliders in the 
Parametric tab don’t cause this problem.

To apply tonal adjustments using the 
Parametric sliders in the Tone Curve tab:
1.	 With a photo open in Camera Raw,A click the 

Tone Curve tab,   then the nested Parametric 
tab. Behind the curve you’ll see a static display of 
the current histogram.

2.	 Do either of the following:

	 If you have already adjusted the Highlights 
and Shadows sliders in the Basic tab, leave the 
Highlights or Shadows sliders in this tab alone 
and just tweak the upper and lower midtones 
using the Lights and Darks sliders. If you didn’t 
adjust the Highlights and Shadows sliders in the 
Basic tab, you can use the sliders here to lighten 
or darken any individual tonal range: Highlights, 
Lights (upper midtones), Darks (lower mid-
tones), or Shadows. As you move a slider, the 

corresponding portion of the curve will be 
raised above or lowered below the diagonal line 
(A–B, next page). 

	 Click the Targeted Adjustment tool  (T). Drag 
within a tonal range of the photo that needs 
adjustment (C, next page). As you do this, the 
slider and curve that correspond to the tonal 
range under the pointer will move accordingly.

➤➤ To boost the contrast in a photo, try moving 
the Lights slider to the right and the Darks 
slider to the left. 

3.	 To control the range of tonal values that are 
affected by the slider adjustments you made in 
the preceding step, move any of the region con-
trols (located below the graph). The left region 
control affects the Shadows slider, the right 
region control affects the Highlights slider, and 
the middle region control affects both the Lights 
and Darks sliders (D–E, next page). Move a 
control to the left to raise the curve and lighten 
adjacent tonal ranges, or move a control to the 
right to lower the curve and darken adjacent 
tonal ranges. 

➤➤ To use one shortcut to get to the nested 
Parametric tab in the Tone Curve tab and 
select the Targeted Adjustment tool, press 
Ctrl-Alt-Shift-T/Cmd-Option-Shift-T.

A In this photo, the midtones are too dark — few details are visible in those areas.
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A To lighten the lower midtones, we 
increased the Darks value. This adjustment 
raised the middle of the curve.

D Finally, we moved the middle region 
control slightly to the right, which had 
the effect of increasing the contrast and 
lightening the sky. 

B More details are now visible in the lightened midtones, such as on the sides of the 
buildings and on the side and surface of the canal. However, the sky looks a bit dull.

E Now the tonal values in the image look just right.

C To lighten the upper mid-
tones (and thereby brighten 
the clouds, sky, and trees), we 
dragged upward over a light 
midtone area with the Targeted 
Adjustment tool;   the Lights 
value increased automatically. 
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All digital cameras produce some luminance (gray-
scale) noise and color artifacts (randomly colored 
pixels). Although budget cameras tend to produce 
the most noise, it can also be produced by a high-end 
camera if it’s used with a high ISO (light sensitivity) set-
ting in a poorly lit scene. It’s a good practice to remove 
as much noise from your photos as possible in Camera 
Raw, because it can become accentuated by image 
editing in Photoshop. 

As you follow these steps, you’ll discover that after 
you shift one slider, another slider will need adjusting.

To reduce luminance and color noise 
using the Detail tab: 
1.	 With a photo open in Camera Raw (A, next page), 

click the Detail tab  and choose a zoom level of 
200–300% for the preview.

2.	 To reduce grayscale noise (graininess), increase 
the Luminance value (B, next page). Try a value 
between 20 and 70.

3.	 Increasing the Luminance can cause high-contrast 
edges in a photo to lose definition. To resharpen 
edges, raise the Luminance Detail value — but not 
so much that you reintroduce noise (C, next page). 

➤➤ To move a different area of the photo into 
view, hold down the Spacebar and drag.

4.	 Raise the Luminance Contrast value to restore 
some edge contrast. The effect of this slider is most 
noticeable in photos that contain a lot of noise.

5.	 Color artifacts and random speckling tend to be 
most noticeable in solid-color areas of a photo 
(e.g., flat surfaces), especially in shadow areas. 
To reduce these defects in a raw photo, increase 
the Color value to around 40–50, depending on 
the subject matter (for a JPEG photo, which has a 
default Color value of 0, use a lower Color value).

6.	 Raising the Color value may lower the intensity of 
colors in areas of the photo that were poorly lit. 
To restore some saturation and intensity to those 
areas, increase the Color Detail value from the 
default value of 50 to around 75, or just until the 
color saturation looks good (D, next page). 

7.	 To help reduce color mottling and artifacts in dark, 
low-contrast (low-frequency) areas of the photo, 
use the Color Smoothness slider.

8.	 Lower the zoom level for the preview to judge the 
overall effect of the Detail settings.

Using the Detail tab
Via the Sharpening sliders in the Detail tab, you can 
adjust the sharpness of your photo (a process called 
“capture” sharpening), and via the Noise Reduction 
sliders, you can reduce any unwanted color noise.

To sharpen a photo using the Detail tab:
1.	 Click the Detail tab  A and choose a zoom level 

of 100%. In the preview, drag to reveal an area of 
the photo that has some detail (hold down the 
Spacebar for a temporary Hand tool).

	 Note: If the words “Sharpening (Preview Only)” 
display at the top of the Detail tab, click the Open 
Preferences Dialog button     in the toolbox. In 
the Camera Raw Preferences dialog, choose Apply 
Sharpening To: All Images, then click OK.

2.	 Under Sharpening, adjust the Amount value for 
the degree of edge definition. For subject matter 
that needs a lot of sharpening, such as hard-edged 
objects or buildings, try a value of 100; if less 
sharpening is needed, try a value of 50–60. (For a 
raw photo, the default Amount value is 25; for a 
JPEG photo, the default value is 0.)

➤➤ To better evaluate the Amount value via a 
grayscale preview, Alt-drag/Option-drag the 
slider.

3.	 Use the Radius slider to control how many pixels 
surrounding each sharpened edge are modified. 
We keep this value between 1 and 1.3.

4.	 Alt-drag/Option-drag the Detail slider slightly to 
the right to emphasize edge details and textures.

5.	 Alt-drag/Option-drag the Masking slider to around 
50 to protect low-contrast areas with a black mask, 
and thereby sharpen only high-contrast areas.

A These are the Sharpening controls in the Detail tab.
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A This is a close-up of a photo of a 
shop window (viewed at a zoom level 
of 300%), with the Noise Reduction: 
Luminance and Color sliders in the 
Detail tab set to 0 (no noise reduction 
applied). Grayscale noise is evident 
in the signage, and color artifacts 
are evident on the poorly lit interior 
surfaces behind the letters. 

D To remove color artifacts from the dark areas, 
we increased the Color value to 40; this also had 
the effect of desaturating the colors. To revive the 
colors and produce the final version of the image 
(shown at left), we increased the Color Detail 
value to 60.

B To remove noise from the letters, we increased 
the Luminance value to 69, but this also dimin-
ished the edge definition.

C To resharpen the 
edges of the letters, we 
increased the Luminance 
Detail value to 65.

ANOTHER WAY TO 
REDUCE NOISE
To reduce noise in select 
areas via the Adjustment 
Brush tool and a mask, see 
pages 72–76.
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Using the HSL/Grayscale tab
Using the powerful sliders in the HSL/Grayscale tab, 
you can adjust the hue, saturation, and luminance of 
each color component of a photo individually.

To adjust individual colors via the HSL 
sliders:
1.	 Click the HSL/Grayscale tab,   and double-

click the Hand tool    to fit the image in the 
preview.A

2.	 Click the nested Hue tab. Move any slider to 
shift that color into adjacent hues, as shown in 
the bar. For example, you could shift the Greens 

slider toward yellow to make a landscape look 
warmer, or toward aqua to make it look cooler. 

3.	 Click the Saturation tab. Move any slider to the 
left to desaturate that color (add gray to it) or to 
the right to make it more vivid (pure).B–C Avoid 
oversaturating the photo, to keep it looking real-
istic and so it stays printable. 

➤➤ �To make a bluish sky more vivid, increase the 
saturation of the Blues and Aquas. To make a 
sunset look warmer, increase the saturation 
of the Oranges or Yellows.

A In the original photo, the sky lacks contrast and the reds on the car body 
are slightly undersaturated. 

C The Saturation adjustments intensified the reds in the car (particularly in 
the upper midtones) and intensified the blues in the sky.

B In the nested Saturation tab of the HSL/
Grayscale tab, we reduced the saturation of 
the Yellows and increased the saturation of the 
Reds and Blues.



Camera Raw    71 

A In the nested Luminance tab, we lightened 
the Oranges and darkened the Reds, Yellows, 
Greens, and Blues. (Tip: Reducing the Blues 
value can make a photo look as if it was shot 
with a polarizing filter on the camera.)

B Decreasing the luminance of the Blues darkened the colors in the sky, 
while decreasing the luminance of the Reds and increasing the luminance of 
the Oranges produced a brighter, richer red on the car body. Now the colors 
are equally intense in the upper and lower areas of the photo.

USING THE TARGETED ADJUSTMENT TOOL
To apply local color adjustments to a photo, 
hold down Ctrl-Alt-Shift/Cmd-Option-Shift and 
press H, S, or L. The nested Hue, Saturation, 
or Luminance tab in the HSL/Grayscale tab 
displays and the Targeted Adjustment tool  
becomes selected. Drag upward or to the right 
over a color area to increase the slider values 
specifically for that area, or downward or to 
the left to decrease those values. The sliders 
that correspond to the color under the pointer 
will shift automatically.

4.	 Click the Luminance tab.A–B Move a slider to 
the left to darken that color (add black) or to the 
right to lighten it (add white). Avoid lightening 
any of the colors too much, to prevent the high-
lights from being clipped.

➤➤ For a more accurate rendering of your adjusted 
pixels, choose a zoom level of 66% or 100% for 
the Camera Raw preview.
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Using the Adjustment Brush tool 
Unlike corrections that are made in the Camera Raw 
tabs, which apply to the overall photo, corrections 
made with the Adjustment Brush tool are “local” 
(affect specific areas of the photo). You apply a mask 
in the preview to define which areas are going to be 
affected by the adjustment, then you apply the cor-
rection via the sliders, including the Whites and Blacks 
sliders.★ Use this tool after you have finished your 
broad, overall corrections, to fix a few specific areas or 
to accentuate some details.A Awesome feature!

To apply local edits with the Adjustment 
Brush tool:
1.	 After making adjustments in the Basic and Tone 

Curve tabs, click the Adjustment Brush tool  (K). 
The sliders for the tool display (some are like the 
sliders in the Basic tab).

2.	 Click the + or – button for any slider to “zero out” 
all the sliders except the one you click.

3.	 For the brush settings (the last four sliders), try a 
Feather value of 50–95 (to allow the edits to fade 
into surrounding areas), a Flow value of 60 (for the 
amount of adjustment produced by each stroke), 
and a Density value of 60 (for the level of transpar-
ency in the stroke).

4.	 Check Mask (Y) (scroll down in the settings area 
if you don’t see this option), adjust the brush size 
by pressing [ or ], then draw strokes over areas of 
the photo that need the same adjustment. A tint 
covers the areas where you apply strokes, and a pin 
appears where you started dragging.B

➤➤ The brush size is represented by the solid circle 
in the pointer; the feather value is represented 
by the black-and-white dashed circle.

5.	 Uncheck Mask, then use the sliders to apply adjust-
ments to the masked areas (A, next page).

➤➤ To show or hide all the pins, press V or check or 
uncheck Overlay. 

➤➤ To display the mask for an existing pin tempo-
rarily, with your mouse or stylus, roll over the 
pin.

B We clicked the Adjustment Brush tool, zeroed out the 
sliders, checked Mask, then drew strokes on the broad areas 
of the face in the preview, being careful to avoid the key 
facial features.

A We studied this photo and decided what improvements 
to make: Smooth the skin, sharpen the eyelashes, darken 
the eyebrows, and minimize the under-eye circles. 
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A We hid the mask, then chose a higher 
Tint value to add magenta to the skin tones, 
higher Exposure and Shadows values to 
lighten the skin tones, and lower Clarity and 
Sharpness values to smooth the skin texture. 
The results are shown at right.

B To sharpen the eyelashes, we clicked New, showed the 
mask, then covered the lashes using a small brush. 

C We hid the mask, then chose higher Contrast, Clarity, and 
Sharpness values to accentuate the masked areas, and a lower 
Exposure value to darken them.

6.	 To apply different adjustment settings to another 
area of the photo, click New, then repeat steps 2–5 
B–C (and A–E, next page). 

	 If you want to duplicate a pin and its mask, hold 
down Ctrl-Alt/Cmd-Option and drag the pin (you 
don’t have to click it first). Or click a pin, right-click 
it and choose Duplicate from the context menu, 
then drag the new pin.

7.	 To redisplay the main Camera Raw tabs, press H 
(Hand tool).
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D We hid the mask again, then reduced the 
Temperature value to cool the redness of the skin tones; 
increased the Exposure, Highlights, Shadows, Whites, 
and Blacks values to lighten the skin; and reduced the 
Clarity and Sharpness values to soften the skin texture.

E This final image shows the cumulative results of all the local 
corrections that we applied via the Adjustment Brush tool.

C To minimize the dark circles under the eyes, we 
clicked New, checked Mask, then applied a mask 
to those areas. 

A To darken the eyebrows, we clicked New, checked 
Mask, then masked those areas.

B We hid the mask, then chose a higher Contrast value to 
define the hairs more crisply against the skin, and lowered 
Highlights, Whites, and Blacks values for a darkening effect.
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USING THE AUTO MASK OPTION WITH THE 
ADJUSTMENT BRUSH TOOL
To mask an area according to color, zoom into that 
area. Check Auto Mask (M), position the Adjustment 
Brush tool over the color, scale the brush tip to cover 
just the width of the area, and start drawing a stroke. 
The mask will cover only the areas that match the first 
color area the brush touches. 

➤➤ If you want to change the mask overlay color, click 
the Mask Overlay Color swatch, then choose a color in 
the Color Picker.

A After using the Adjustment Brush tool in this photo, we 
clicked an existing pin, and checked Mask to display the mask 
associated with that pin (we changed our mask color to yellow).

B We dragged with the Adjustment Brush tool to add an 
area to the mask for the currently selected pin (note the brush 
cursor on the right side of the photo).

To edit an Adjustment Brush tool 
correction: 
1.	 Choose the Adjustment Brush tool  (K).

2.	 Check Mask (Y) and Overlay (V).

3.	 Click a pin. A black dot appears in the center of  
the pin.

4.	 Do any of the following:

	 To add areas to the mask, drag with the brush in 
the image preview.A–B

	 To move the mask to a different area of the photo, 
drag its pin.

	 To adjust the correction for the current pin, 
uncheck Mask (Y), then move the sliders.
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To remove Adjustment Brush tool edits:
1.	 Choose the Adjustment Brush tool  (K).

2.	 Check Mask (Y) and Overlay (V).

3.	 Do either of the following:

	 To remove adjustments locally, click a pin, click 
the Erase button (or hold down Alt/Option), then 
apply strokes where you want to erase the mask. A

	 To remove a pin and its adjustments, click the 
pin, then press Backspace/Delete; or right-click a 
selected pin, then choose Delete from the con-
text menu; B or hold down Alt/Option and click 
a selected or unselected pin (note the scissors 
pointer).

➤➤ To remove all Adjustment Brush tool edits from 
the current photo and reset the tool mode to New, 
click the Clear All button.

A We clicked an existing Adjustment Brush pin, and checked 
Mask to display the mask associated with that pin. Next, 
we clicked the Erase button, then dragged with the brush to 
remove an area from the selected mask.

B To remove a selected Adjustment Brush pin, we right-
clicked it and chose Delete from the context menu.
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Using the Split Toning tab
Using the Split Toning controls, you can apply one 
color tint, or tone, to the highlight areas of a photo 
and a different tint to the shadow areas. For the best 
results with this technique (and to mimic its traditional 
origins), convert the colors in your photo to grayscale 
first. We’ve gotten good results on photos of metallic 
objects, such as the antique car shown here.A

To apply a color tint to a grayscale version 
of a photo:
1.	 Click the HSL/Grayscale tab,   then check 

Convert to Grayscale. 

2.	 Click the Basic tab, and adjust the exposure and 
contrast.

3.	 Click the Split Toning tab. 

4.	 Move both of the Saturation sliders approximately 
halfway across the bar to make it easier to judge 
the colors you will apply in the next step (don’t 
worry that the photo looks awful).

5.	 Move the Highlights Hue slider to tint the high-
lights B and the Shadows Hue slider to tint the 
shadows.

6.	 Readjust the Saturation value for each hue.

7.	 Reduce the Balance setting to apply more of the 
Shadows tint to the entire photo, or increase it 
to apply more of the Highlights tint to the entire 
photo.C–D

A This is the original, full-color photo.

B After converting the colors in the photo to grayscale, we 
used the Split Toning tab to tint the highlights with a brownish 
yellow hue.

D This is the final result of our Split Toning adjustments. Applying 
separate tints to the highlights and shadows accentuated the lines and 
graceful curves of this sleek antique.

C Next, we tinted the shadows with blue, 
then moved the Balance slider to the right to 
favor the highlight color more. 
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Using the Lens Corrections tab
Via the Lens Corrections tab in Camera Raw, you can 
correct a photo for various adverse effects of lens dis-
tortion. You can straighten out an architectural feature, 
such as a building or fence, that looks as if it’s leaning 
toward or away from the viewer, or that is tilted hori-
zontally (isn’t level); and you can correct for under- or 
overexposure at the edges of a photo (vignetting). The 
corrections can be applied using a preset profile (this 
page) or manually (next page).

To correct geometric distortion and 
vignetting via Profile settings:
1.	 Click the Lens Corrections tab.   Double-click the 

Hand tool    to fit the image in the preview.

2.	 To access predefined lens profiles, click the Profile 
tab, then check Enable Lens Profile Corrections.

3.	 From the Setup menu,A do the following:

	 Choose Auto to have Camera Raw read the EXIF 
metadata in the photo and attempt to select the 
proper lens make, model, and predefined profile. 

	 If an error message indicates that the Auto option 
was unable to locate a profile, choose your lens 
manufacturer from the Make menu.B Camera Raw 
will locate a matching lens model and list it on the 
Model menu, and will locate a predefined profile 
and list it on the Profile menu. If the Model menu 

lists more than one model, choose the one with 
which the photo was shot.

4.	 Under Correction Amount, do the following:

	 Set the Distortion value to control the amount  
of correction.

	 Set the Vignetting value to correct for under- or 
overexposure at the edges of the photo.

5.	 Optional: If Camera Raw managed to locate your 
lens profile (step 3), you can save that profile and 
any custom Correction Amount settings as your 
new default profile by choosing Save New Lens 
Profile Defaults from the Setup menu. In future 
Camera Raw editing sessions, if you choose Default 
from the Setup menu, and the current photo was 
taken with this lens, the saved profile and settings 
will be applied. (To restore the Adobe predefined 
settings for your chosen lens, from the Setup 
menu, choose Reset Lens Profile Defaults.)

6.	 Optional: If you want to further correct any lens 
distortion manually, see the next task.

➤➤ When applying lens corrections to a Smart Object 
in Photoshop, we use the Lens Corrections tab in 
Camera Raw (accessed via Filter > Camera Raw 
Filter) because it has more extensive manual con-
trols than the Lens Correction filter in Photoshop.

A Check Enable Lens Profile Corrections, 
then choose Auto from the Setup menu …

B … or choose your lens maker from the 
Make menu. Regardless of the Setup option, 
if necessary, adjust the Distortion value.
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To correct geometric distortion or vignetting via the Manual tab:
1.	 Click the Lens Corrections tab,   and double-click 

the Hand tool    to fit the image in the preview.A
2.	 Click the Manual tab.B
3.	 In the Upright area, click a button to apply a preset 

correction:

	 Auto  to apply level correction and fix horizontal 
and vertical convergence, balanced with as little 
distortion as possible.C 

	 Level  to apply only level correction (not fix hori-
zontal or vertical convergence). 

	 Vertical  to apply level correction and fix vertical 
convergence (but not horizontal convergence).

	 Full  for a stronger correction of horizontal and 
vertical convergence, in addition to level correction 
(A, next page).

4.	 If further manual correction is needed, do any of 
the following: 

	 To spread the image out (fix pincushion distor-
tion), lower the Distortion value; or to pinch the 
image inward (fix barrel distortion), increase the 
Distortion value.

➤➤ To display a grid over the image so you 
can check the alignment, check Show 

Continued on the following page

A The original photo (above) shows signs of lens distortion: The house 
looks as if it’s tilting away from the camera, and it’s not level.

B We clicked the Manual tab (under Lens 
Corrections) to access these menu options 
and sliders.

C Under Upright, we clicked the Auto button for a balanced correction. This partially corrected the vertical lines 
and vertical tilt, but the left side of the house still looks as if it’s farther away from the viewer than the right side.



80    Chapter 4

A We clicked the Full button instead, which successfully made the house 
level and upright. To lighten the outer areas of the photo, we increased 
the Amount value (under Lens Vignetting).

Grid or press V. Adjust the grid size via the 
slider.B	

	 To widen the top of the image, (correct key
stoning) reduce the Vertical value; to widen the 
bottom of the image, increase the Vertical value. 
Readjust the Distortion value, if needed.

	 To widen the left edge of the image, reduce the 
Horizontal value; to widen the right edge of the 
image, increase the Horizontal value.

	 To rotate the image, change the Rotate value.

	 To enlarge or shrink the photo, change the Scale 
value. Note: You could crop the photo instead.

	 To stretch the image horizontally or vertically, 
change the Aspect value. This option is useful for 
correcting strong perspective distortion in photos 
taken with a wide-angle lens (A–B, next page).

➤➤ If you moved the Distortion slider, you can 
click Reanalyze (below the buttons) to force a 
recalculation of the Upright correction based 
on the Distortion value. If you want to turn 
off (but preserve) all your Upright corrections, 
click the Off button.   If you click a different 
Upright button, as an alert will inform you, all 
the Transform sliders (except Distortion) will 
be reset to 0.

5.	 To correct or apply Lens Vignetting (lighten or 
darken the outer areas of the photo), set the 
Amount value for the strength of the correc-
tion, then set the Midpoint value to expand the 
vignette inward or outward. Readjust the Amount 
value, if needed.

B We made some minor 
Vertical and Rotate adjust-
ments, with Show Grid checked 
to help us gauge the effect.
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A We tried increasing the Aspect value, but 
this setting exaggerated and distorted the ver-
ticals of the house too much.

SYNCING LENS CORRECTIONS TO MULTIPLE PHOTOS ★
To apply Lens Corrections edits to multiple photos opened in Camera Raw:

➤➤ If the photos don’t require 
exactly the same corrections, click 
one photo and choose settings in 
the Manual tab of Lens Corrections. 
On the left side of the dialog, right-
click a thumbnail and choose Select 
All; right-click again and choose 
Sync Settings. In the dialog, choose 
Lens Corrections from the menu, 
check only Transform and Lens 
Vignetting, then click OK. Camera 
Raw will analyze and correct each 
photo separately (see also page 94). 

➤➤ If the photos do require exactly 
the same correction (e.g., brack-
eted shots of the same subject), 
click one photo, then click an 
Upright button in Lens Corrections. 
On the left side of the dialog, 
right-click a thumbnail and choose 
Select All, then click Sync Results 
in Lens Corrections. The first photo 
will be analyzed according to the 
chosen Upright mode, then the 
same correction will be applied to 
all the other photos.

B Instead, we set the Aspect value to –5, which exaggerated the horizontal propor-
tion only slightly. The final settings we chose for the image are shown at right.
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Using the Effects tab
In traditional photography, the faster the film speed, the 
larger and more apparent the grain. As an intentional 
effect, you can simulate this grainy texture via the Grain 
controls in Camera Raw. Choose a photo that won’t 
suffer aesthetically when its details lose definition.

To add a grain texture to a photo: 
1.	 Click the Effects tab,   and double-click the Hand 

tool  to fit the image in the preview.A
2.	 To create a noticeable grain, under Grain, choose an 

Amount value of around 50.

3.	 To emulate the fine grain of slow film or the coarse 
grain of fast film, do as follows:

	 Set the Size value for the size of the grain particles.B 
When this value is greater than 25, a small degree of 
blurring is also applied, to help blend the grain with 
the imagery.

	 Reduce the Roughness value below the default 
value of 50 for a more uniform grain, or increase it 
for an uneven, coarse grain.C Zoom in to examine 
the grain, then readjust the Amount value, if needed.

C We increased the Amount to 75, the Size to 60, and the 
Roughness to 65. The coarser grain unifies the highlights and 
background with the food textures even more. Please pass 
the Parmesan…

B The first settings we chose were Grain Amount 50 and 
Size 80 (we left the Roughness control at the default value of 
50). The food textures are beginning to blend with the soft 
background. 

A This photo is a good candidate for the Grain effect 
because we won’t mind if the details are softened and 
it contains muted colors.
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Using the Post Crop Vignetting controls, you can apply a 
light or dark vignette to a photo (lighten or darken the  
outer areas). If you crop the photo subsequently in Camera 
Raw, the vignette will reconform to the new dimensions.

To apply a vignette to a photo: 
1.	 Click the Effects tab,   and double-click the Hand 

tool    to fit the image in the preview.A
2.	 Under Post Crop Vignetting, do all of the 

following: B–D
	 Choose Style: Highlight Priority.

	 Choose a negative Amount value for a dark vignette 
or a positive value for a light vignette.

	 Adjust the Midpoint value to expand the vignette 
inward or outward.

	 Adjust the Roundness value to make the vignette 
shape more oval or more like a rounded rectangle.

	 Adjust the Feather setting to control the softness  
of the transition to the nonvignetted areas.

	 Adjust the Highlights setting to control the bright-
ness of the highlights within the vignette area.

A This is the original image.

C We lowered the Midpoint value and 
raised the Feather and Highlights values.

D When we cropped the image, the 
vignette readjusted automatically. 

B In the Effects tab, under Post Crop 
Vignetting, we chose the values above.
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Outdoor photos capture not only objects in the scene, 
but also the atmospheric conditions — namely haze. 
The Dehaze slider can be used to control how much 
haze is either removed from or added to the photo. 

To decrease or increase haze in a photo: ★
1.	 Click the Basic tab,   and double-click the Hand 

tool  to fit the image in the preview. Do the 
following:

	 Adjust the White Balance; increase the Exposure 
value; increase the Shadows value to lighten the 
shadows; increase the Whites value; increase the 
Clarity value to sharpen edge contrast; and adjust 
the other slider values as needed. A–B

2.	 Click the Effects tab.   Do either of the following:

	 Enter a positive Dehaze value to decrease the 
amount of haze. This will increase both the tonal 
and color contrast and intensify color in the photo 
(A, next page).

	 Enter a negative Dehaze value to increase the 
amount of haze (or fog). This will add a soft white 
tint that reduces tonal and color contrast and 
softens the detail in the photo (B, next page). 

3.	 Go back to the Basic tab and readjust those 
sliders, if desired. We recommend you experiment 
with different Shadows, Blacks, and Clarity values 
(C, next page).

B … to initially adjust our photo. This photo is a good candidate for the Dehaze 
effect because it contains adequate overall contrast, a substantial amount of 
whites, dark contrasts in the midground, and very few areas of green.

A In the Basic tab, we used the settings 
shown above…
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A We set the Dehaze value 
to +48. The photo now has 
substantial tonal contrast and 
greater color saturation and 
intensity. An amazing result 
from one slider adjustment! 

B Next, we changed the Dehaze 
value to –73. In the Basic tab, we 
lowered the Clarity value to +28 and 
the Blacks value to –44. The Dehaze 
effect has transformed the scene into 
a gray, foggy day, with a soft white 
tint enveloping the scene from the 
foreground to the background.

C Finally, in the Basic tab, we 
reduced the Clarity value to –44 
and the Blacks value to –53. This 
adjustment softened the entire 
image and removed some of the 
haze from the closest foreground 
elements.

By experimenting in the Basic 
tab, we found that the Shadows 
and Blacks sliders can control the 
amount of haze in the foreground, 
while the Contrast and Highlights 
sliders can control the amount of 
definition in background.
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Using the Graduated Filter tool
When shooting landscapes, you may have run into 
this common predicament: You set the proper expo-
sure for the foreground, and the sky winds up being 
overexposed. To solve this problem on site, you can 
reduce the light on the upper part of the lens with a 
graduated neutral-density filter. To darken a sky in  
a photo that is shot without such a filter (Plan B!), you 
can use the Graduated Filter tool in Camera Raw. 

With this tool, you create an overlay to define the 
area to be edited, then you apply the adjustment via 
any of a dozen sliders. The slider options are the same 
as for the Adjustment Brush tool.

To adjust an area of a photo using the 
Graduated Filter tool:
1.	 After adjusting your photo via the Basic and 

Tone Curve tabs,A choose the Graduated Filter 
tool  (G). The sliders for the tool display in the 
right panel.

2.	 Click the + or – button for any slider to “zero out” 
all the sliders except the one you click.

3.	 To define where the filter edits will be applied, 
Shift-drag over an area in the photo, beginning 
from the location where you want the adjustment 
to be strongest. The filter will be applied fully at 
the green dashed border of the overlay, gradually 
diminishing to nil at the red dashed border. Note: 
If you want to draw the overlay on a diagonal, 
don’t hold down Shift while dragging.

4.	 Do either or both of the following:

	 Use the Temperature and/or Tint slider to make 
the filtered area warmer or cooler.

	 Use other sliders to adjust such characteristics as 
the exposure, sharpness, whites or blacks,★ or 
noise in the filtered area (A–C, next page).

5.	 To redisplay the main tabs, press H (for the Hand 
tool).

➤➤ At any time, you can lengthen or shorten the filter 
overlay by dragging or Shift-dragging the green 
or red dot. To reposition the whole overlay, drag 
the line that connects the two dots. 

➤➤ To apply a separate overlay to another area of 
the photo, click New, then repeat steps 2–4. If 
you want to clone an overlay, hold down Ctrl-Alt/
Cmd-Option and drag the dashed line that  
connects the two pins; or right-click a selected 
overlay and choose Duplicate from the context 
menu, then move the duplicate overlay.

➤➤ To hide the filter overlay, uncheck Overlay or 
press V. 

➤➤ To remove a filter overlay, right-click a selected 
pin then choose Delete from the context menu; 
or hold down Alt/Option and click the overlay 
(note the scissors pointer); or click the overlay, 
then press Backspace/Delete.

A Despite our applying Basic and Tone Curve adjustments, the sky in 
this photo looks overexposed (washed out).

EDITING A GRADUATED OR RADIAL 
FILTER MASK WITH A BRUSH

➤➤ Create or select a filter overlay. Click 
the Brush button at the top of the panel 
(Shift-K) to display brush options, then click 
the Brush + (add to) or Brush – (erase from) 
button. Press [ or ] to size the brush, then 
apply strokes in the preview. (You can also 
toggle the plus and minus buttons for the 
brush by holding down Alt/Option.) If you 
want to choose different sizes for the plus 
and minus functions of the brush, check 
Separate Eraser Size on the panel menu.

➤➤ In the panel, you can set the Feather 
value to control how much the brush edits 
fade into surrounding areas, and the Flow 
value to control the amount of adjustment. 
Check Auto Mask (M) to mask only the areas 
that match the first color area the brush 
touches (see also the sidebar on page 75). 

➤➤ To remove all manual brush strokes from 
the currently selected overlay, click Clear.
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C In the final image, the adjustment is strongest in the sky, fading to nil in the upper 
part of the ground.

A After zeroing out the sliders for the Graduated Filter tool, we Shift-dragged 
downward in the photo (as shown by the arrow above), then chose slider settings 
to darken the exposure within the overlay area. 

B To add more blue to the upper area of 
sky, we lowered the Temperature value.
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Using the Radial Filter tool
With the Radial Filter tool, you define an elliptical area 
with an overlay, then apply adjustments via sliders to 
the area either inside or outside the overlay.

To darken an area of a photo via the 
Radial Filter tool:
1.	 After adjusting your photo via the Basic and Tone 

Curve tabs,A click the Radial Filter tool  (J). The 
sliders for the tool display.

2.	 Click the + or – button for any slider to “zero out” 
all the sliders except the one you click. At the 
bottom of the panel, click Effect: Outside or Inside 
to control where the filter effect will occur relative 
to the overlay you will draw in the next step.

3.	 Drag over an area in the photo to produce an 
overlay.B If you want to reposition the overlay as 
you create it, drag with the Spacebar held down. 

4.	 Use any of the sliders, including the Whites and 
Blacks sliders,★ to adjust the filtered area (A–C, 
next page). If the Effect setting is Outside, the 
adjustment will be at full strength outside the 
overlay, then diminish gradually to no adjustment 
at the dashed border. If the Effect setting is Inside, 
the adjustment will be at full strength at the 
center of the overlay and diminish gradually to  
no adjustment at the dashed border.

A Although the exposure in this photo is well bal-
anced, we want to spotlight the spa products more.

B We zeroed out the sliders for the Radial Filter tool, then dragged in the preview to create an overlay.
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5.	 To control how gradual the adjustment is at the 
edge of the overlay, use the Feather slider.

6.	 To hide the overlay(s) to gauge the adjustment, 
uncheck Overlay or press V. Redisplay the overlay 
for the next step.

7.	 To edit the overlay, do any of the following (all 
optional):

	 To reposition the overlay, drag inside it. 

	 To reshape the overlay, drag one of its handles.

	 To resize the overlay, Shift-drag a handle. 

	 To swap the adjustment from Outside to Inside 
the overlay, or vice versa, click the unselected 
Effect button or press X. 

8.	 Optional: To add another overlay, click New, then 
follow steps 2–7. To clone an overlay, hold down 

Ctrl-Alt/Cmd-Option and drag its center pin; or 
right-click the pin and choose Duplicate from 
the context menu, then drag the new pin. Note: 
Adjustments are cumulative where overlays over-
lap; to edit adjustment settings, click a pin first. 

9.	 To redisplay the main tabs, press H (Hand tool).

➤➤ To delete an overlay, select its center pin, then 
right-click the pin and choose Delete from the 
context menu; or hold down Alt/Option and click 
the pin (scissors pointer); or click the pin, then 
press Backspace/Delete. 

➤➤ To expand an overlay to the edges of a photo, 
double-click inside it; or to do this when creating 
a new overlay, double-click in the preview. 

A We used the first four sliders to darken the filtered 
area and the Clarity and Sharpness sliders to soften the 
image details.

B To make the lighting in the darkened 
areas cooler, we reduced the Temperature 
value (added blue).

C The tonal, tempera-
ture, and sharpness 

adjustments helped to 
accentuate the candle, 
soap, and white bottle.

EDIT THE MASK 
WITH A BRUSH
To edit a Radial 
Filter mask with a 
brush, follow the 
steps in the side-
bar on page 86.
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Using the Spot Removal tool
Use the Spot Removal tool to remove imperfections 
from a photo, such as spots caused by dust on the 
camera lens, blemishes in a portrait, or insects on 
flowers. You can let Camera Raw locate a source area 
for the repair automatically, or you can choose a 
source area.

The Spot Removal tool does an improved job of 
locating a source area automatically, especially when 
used to heal nonsmooth textures (Adobe mentions 
bark, rocks, and foliage as examples of textures in 
which healing results are improved). Also, if you use 
this tool on a photo that you cropped in Camera Raw, 
the tool will look for source areas within the crop 
boundary first.

To remove blemishes or spots:
1.	 Choose the Spot Removal tool  (B).

2. 	 Zoom in on an area to be repaired.

3.	 Press [ or ] to size the brush cursor, then do one of 
the following: 

	 Ctrl-Alt-drag/Cmd-Option-drag outward from the 
center of a blemish to create and scale a target 
circle A; or click a blemish; or if you want to con-
trol which area Camera Raw uses as the source, 
Ctrl-drag/Cmd-drag from the target area to the 
desired source area. When you release the mouse, a 
red dashed circle surrounds the target region and 
a green dashed circle surrounds the source area.B

	 Drag across a blemish to create a target region.  
When you release the mouse, a border with a red 
pin surrounds the target region and a border with  
a green pin surrounds a source region.C–E

A With the Spot Removal tool, we 
held down Ctrl-Alt/Cmd-Option and 
dragged to create a target circle 
around a blemish.

B The tool created a linked source 
circle in a similar area and repaired 
the blemish. 

E The line is eliminated from the leaf.

D The tool created a source 
region and two pins.

C To remove an imperfection 
from a leaf, we’re dragging to 
create a target region.
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➤➤ To display a black-and-white version of the 
photo to help you pinpoint dust spots or other 
irregularities, check Visualize Spots (Y). Adjust 
the black-to-white threshold via the slider. 
Press Y to return to the normal display.

4.	 Optional: To soften the transition between the cur-
rent target area and surrounding areas, adjust the 
Feather value.A–C Or to adjust the Feather value 
interactively (within the current size of the brush 
cursor), with Shift and right-click held down, drag 
horizontally in the preview. The new Feather value 
will display within the selected target area. The 
Feather value is sticky, meaning the current value 
will persist for future editing sessions until you 
change it.

5. 	 From the Type menu, choose Heal to blend source 
pixels into the texture and luminosity values of the 
target pixels (often the best choice), or Clone to 
copy the source pixels exactly without any healing. 

	 Optional: To cycle through alternative source 
locations that Camera Raw detects, press (and 
keeping pressing) /.

6.	 To hide all regions and circles at any time in 
order to judge the Spot Removal results, uncheck 
Overlay (V). Recheck it for the remaining steps.

7.	 Select a target or source region by clicking its pin, 
or select a circle by clicking inside it, then do any  
of the following optional steps:

	 To reposition a region or circle, drag inside it.

	 To control the opacity of the repair, change the 
Opacity value in the panel.

	 To resize a pair of target and source circles (not 
irregular-shaped regions), drag the dashed border.

	 To add to an existing region (or to convert a circle 
to a region), position the pointer just outside it, 
then hold down Shift and click or drag.

8.	 Optional: Create more regions or circles to correct 
other blemishes. 

	 To remove a pair of circles or regions, hold down 
Alt/Option and click in the target or source area; 
or to delete multiple circles and/or regions, Alt/
Option drag a marquee across them; or to remove 
all Spot Removal circles and regions, click Clear All.

9.	 To redisplay the main tabs, press H (Hand tool).

➤➤ To redisplay the current Spot Removal overlays at 
any time, choose the tool again (press B).

B Using the Spot Removal tool, we dragged outward from 
the center of the shed. With the Feather value for the tool set 
to 100%, the healing is fading around the rim of the circle, 
and sections of the original background aren‘t replaced.

C We changed the Feather slider for the tool to 10%. Now 
the shed is more fully replaced with tree pixels, with mini-
mal fading along the rim of the target region.

A The shed in this photo is a distracting element.
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Saving and applying Camera Raw 
settings
After carefully choosing custom settings for a photo in 
Camera Raw, you’ll be glad to know that you can save 
those settings as a preset and then apply the preset to 
other photos that need the same or similar corrections. 

To save Camera Raw settings as a preset: 
Method 1 (Camera Raw Settings menu)
1.	 With your corrected photo open in Camera Raw, 

choose Save Settings from the Camera Raw 
Settings menu.   

2.	 The Save Settings dialog opens.A 

3.	 Choose Subset: All Settings, then check the catego-
ries of settings you want saved in the preset. If you  
want to filter which boxes are checked for a subset, 
choose a tab name from the Subset menu, then 
check/uncheck boxes. For any menu choice, you can 
also click Check All or Check None; or to select one 
box exclusively, hold down Alt/Option and click it.

4.	 Click Save. A “navigation” Save Settings dialog 
opens. Enter a name (preferably one that describes 
the function of the preset), keep the location as the 
Settings folder, then click Save.

5.	 The saved settings preset is now available in the 
Presets tab  for any open photo.

Method 2 (Presets tab)
1.	 With your corrected photo open in Camera Raw, 

click the Presets tab,   then click the New Preset 
button.   

2.	 In the New Preset dialog, enter a name for the 
preset. Follow step 3, above.

3.	 Click OK. Your new preset is now available in the 
Presets tab for any open photo.

➤➤ To delete a user-saved preset, click the preset 
name, then click the Delete button.   

You can apply a user-defined preset (saved collec-
tion of settings) to a single photo via Camera Raw 
(see below), to multiple photos via Bridge (see the 
following page), or to multiple thumbnails via the 
Synchronize option in Camera Raw (see page 94).

To apply a Camera Raw preset to a photo: 
	 With a photo open in Camera Raw, click the 

Presets tab,   then click a preset name.

➤➤ You can also apply a preset via the Apply Preset 
submenu on the Camera Raw Settings menu.

A In the Save Settings dialog, check which categories of 
custom Camera Raw settings are to be saved in a preset.

TAKING SNAPSHOTS OF YOUR CR SETTINGS
A snapshot is a record of the current Camera Raw 
settings that you have chosen for a photo. By saving 
snapshots of your photo periodically while editing 
it, you preserve the option to restore the photo 
to those earlier settings. Unlike snapshots on the 
History panel in Photoshop, snapshots save with 
the Camera Raw file. Click the Snapshots tab,   
then click the New Snapshot button.    In the New 
Snapshot dialog, enter a name, then click OK. To 
restore the photo to a snapshot at any time, click a 
snapshot name in the Snapshots tab. (For other ways 
to restore Camera Raw settings, see pages 59–60.) 

➤➤ To update an existing snapshot with the current 
settings, right-click the snapshot listing and choose 
Update with Current Settings from the context menu.
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The settings presets that you save in the Presets tab of 
the Camera Raw dialog can also be applied to multiple 
photos via the Develop Settings submenu in Bridge. In 
fact, as a strategy, you could save separate presets for 
settings in individual Camera Raw tabs and then assign 
them to multiple photos in succession (e.g., a preset for 
the Basic tab first, then a preset for the Tone Curve tab, 
and so on). If you haven’t saved the needed settings 
as presets, a quick alternative method is to copy and 
paste all the current settings from one photo into one 
or more other photos.

To apply Camera Raw settings to multiple 
photos via Bridge: 
Method 1 (apply a preset)
1.	 In Bridge, Ctrl-click/Cmd-click multiple photo 

thumbnails (or Shift, then Shift-click a consecutive 
series of thumbnails).

2.	 To apply settings, from the Edit > Develop Settings 
submenu, choose a preset; or right-click a selected 
thumbnail and choose a preset from the Develop 
Settings submenu on the context menu.A Choose 
additional presets, if needed.

Method 2 (copy and paste settings from a photo)
1.	 Click the thumbnail for a photo that has the 

desired settings, then choose Edit > Develop 
Settings > Copy Camera Raw Settings (Ctrl-Alt-C/
Cmd-Option-C), or right-click the selected thumb-
nail and choose Develop Settings > Copy Settings 
from the context menu.

2.	 Click another thumbnail (or Ctrl-click/Cmd-click 
multiple thumbnails), then choose Edit > Develop 
Settings > Paste Camera Raw Settings (Ctrl-Alt-V/
Cmd-Option-V), or right-click the selected thumb-
nail and choose Develop Settings > Paste Settings 
from the context menu.

3.	 The Paste Camera Raw Settings dialog opens. 
Uncheck any settings you don’t want to paste; or 
choose a tab name from the Subset menu, then 
remove or add any check marks; or to select one 
box exclusively, hold down Alt/Option and click it. 
Click OK.

➤➤ To remove all Camera Raw settings from a selected 
photo thumbnail in Bridge, choose Edit > Develop 
Settings > Clear Settings or right-click the thumb-
nail and choose Develop Settings > Clear Settings 
from the context menu. 

A Using commands on the Develop Settings submenu in Bridge, you can apply one or more saved settings presets to multiple 
selected thumbnails, or copy and paste the current settings from one thumbnail to other thumbnails.
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Synchronizing Camera Raw 
settings
When you open multiple photos into Camera Raw, 
they are represented by thumbnails in a panel on the 
left side of the dialog. After adjusting one photo, you 
can use Sync Settings to apply those settings to one 
or more of the other photos. Because it’s unlikely that 
every single adjustment needed for one photo will be 
perfectly suited to all the others (even photos taken 
during the same shoot), a more practical approach is 
to adjust subsets of the grouping. For instance, you 
could apply a settings preset or some Basic tab adjust-
ments to one photo (say, to correct the white balance 
and exposure), apply those settings to most or all of 
the other photos, then select specific photos and apply 
more targeted or specialty adjustments.

To synchronize the Camera Raw settings 
among multiple photos:
1.	 In Bridge, select two or more photo thumbnails, 

preferably ones that were shot under the same 
lighting conditions and that require the same kind 
of correction (for the most accurate and consistent 
corrections, select all raw files or all JPEG files). 
Double-click one of the selected thumbnails.

2.	 On the filmstrip panel on the left side of the 
Camera Raw dialog, click one of the thumbnails.A 

3.	 Make the needed adjustments to the selected 
image (including cropping, if you want to crop all 
the images in exactly the same way). You can apply 
adjustments via the tabs or tools or by clicking a 
preset in the Presets tab. 

4.	 Right-click a thumbnail. From the context menu 
choose Select All; right-click again and choose 
Sync Settings. Or Ctrl-click/Cmd-click specific 
thumbnails, then right-click a selected thumbnail 
and choose Sync Settings.★

5.	 The Synchronize dialog opens (it looks like the 
Save Settings dialog, which is shown on page 92). 
Check only the settings you want to apply to all 
the selected thumbnails; or choose a category 
from the Synchronize menu, then remove or add 
any check marks. Click OK.

➤➤ To cycle through the photos on the filmstrip panel, 
click the left or right arrowhead below the preview 
(in the lower right). If more than one thumbnail is 
selected, Camera Raw will cycle among only the 
selected photos.

A We opened four photos into Camera Raw. The thumbnails 
for the images display on the filmstrip panel on the left side of 
the dialog.

NEW MERGE COMMANDS IN CAMERA RAW ★
Camera Raw enables you to apply the Merge to HDR 
and the Merge to Panorama commands to photos 
via the filmstrip panel menu or via the panel context 
menu. See pages 258–259 and 292–293 for steps for 
using these commands.

WHERE CR IMAGE SETTINGS ARE SAVED
Depending on the current setting on the Save Image 
Settings In menu in the Camera Raw Preferences dia-
log (Ctrl-K/Cmd-K), settings for raw photos (not JPEGs) 
are saved either in the internal Camera Raw Database 
on your system or as hidden Sidecar .xmp Files in the 
same folder as the raw files.
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Converting, opening, and saving Camera Raw files
Still with us? At long last, you get to open your Camera 
Raw file into Photoshop.

To open a photo from Camera Raw into 
Photoshop:
1.	 After applying adjustments to your photo in 

Camera Raw, click Open Image; or if you opened 
and corrected multiple files, select them on the 
left side of the dialog, then click Open Images. 

2.	 The photo appears as the Background in a new 
Photoshop document (or documents). Save the 
file(s) in the Photoshop (PSD) format. 

	 Note: If Open in Photoshop as Smart Objects is 
checked in the Workflow Options dialog (see step 
10 on page 56), the Open Image button is labeled 
Open Object and a photo opens as a Smart Object 
in a new Photoshop document. To learn about 
Smart Objects, see pages 272–283 (to edit the 
Camera Raw settings of a Smart Object, see page 
276). If the workflow option is off, you can convert 
the Open Image button to Open Object by hold-
ing down Shift.

➤➤ To close the Camera Raw dialog without open-
ing your file, but save your settings to the file as 
instructions, click Done. The settings will redisplay 
if you reopen the file in Camera Raw.

If desired, you can open a copy of a Camera Raw file with 
its current (custom) settings into Photoshop without 
changing the settings in the original raw or JPEG file.

To open a copy of a Camera Raw file:
	 In the Camera Raw dialog, hold down Alt/Option 

and click Open Copy (Open Image or Open Object 
becomes Open Copy).

Settings in the Workflow Options dialog are assigned 
automatically to all photos that you open into Camera 
Raw (see pages 56–58). If you want to convert and 
save a copy of an individual photo in the Digital 
Negative (DNG), JPEG, TIFF, or Photoshop (PSD) format 
using custom file naming, format, color space, sizing, 
or sharpening settings instead, use the Save Options 
dialog, as described below. New Color Space, Image 
Sizing, and Preset features, found in the Workflow 
Options dialog, are also available in the Save Options 
dialog.

When you save a copy of a photo in the Digital 
Negative format via Save Options, the Camera Raw 
settings it inherits from the original file remain acces-
sible and editable in Camera Raw. See also the sidebar 
on this page.

When you save a photo in the JPEG, TIFF, or PSD 
format via Save Options, the Camera Raw settings 
are applied to the copy of the photo permanently. 
Although you can open and edit the resulting JPEG or 
TIFF file in Camera Raw, you will see that the sliders are 
reset to their default values. PSD files can’t be opened 
into Camera Raw. 

Note: Settings that you choose in the Save Options 
dialog are independent of — and have no effect on —  
the settings in the Workflow Options dialog. 

To save a copy of a Camera Raw file in the 
DNG, JPEG, TIFF, or PSD format:
1.	 Open and adjust a photo in Camera Raw, then 	

in the lower-left corner of the dialog, click Save 
Image.

2.	 The Save Options dialog opens (A, next page). For 
the Destination, choose Save in Same Location or 
Save in New Location. For the latter, choose a loca-
tion in the Select Destination Folder dialog, then 
click Select. 

ARCHIVING PHOTOS AS DNG FILES
Photographs capture unrepeatable moments, and 
archiving them is both a priority and a concern for 
photographers. Ideally, there would be one standard 
file format for digital photos that photographers 
could depend on with confidence, knowing their 
photos will be stable and accessible for the foresee-
able future. At the present time, each camera maker 
uses a unique, proprietary format for their raw files. 
Should a maker discontinue its format, raw photos 
from their cameras might become unreadable by 
Photoshop or other image-editing applications.

Luckily, DNG (short for Digital Negative), a format 
developed by Adobe, preserves all the raw, unpro-
cessed pixel information that is captured by the 
camera. The coding for the DNG format is nonpropri-
etary (open standard), meaning that it is accessible to 
all interested companies. DNG may be the long-term 
solution that photographers will eventually come to 
rely on — provided it is adopted as the standard by a 
majority of camera and software manufacturers.

Continued on the following page
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3.	 Under File Naming, choose a naming or num-
bering convention from the menu or enter a file 
name. If desired, you can also choose an addi-
tional naming or numbering convention from 
the adjacent menu. 

4.	 Choose a Format of Digital Negative, JPEG, TIFF, 
or Photoshop, then choose related options. For 
instance, if you cropped the photo in Camera 
Raw and then choose the Photoshop format 
here, you will need to decide whether to check 
Preserve Cropped Pixels.

5.	 For a photo in the JPEG, TIFF, or Photoshop 
format, choose an option from the Metadata 
menu to control what metadata will be saved 
with the file. And via the Remove Location Info 
check box, control whether you want location 
information for the file to be preserved. 

6.	 For a photo in the JPEG, TIFF, or Photoshop 
format, you can choose options under Color 
Space, Image Sizing, and Output Sharpening. 
For Color Space, see step 3 on page 56; for Image 
Sizing, see page 58; and for Output Sharpening, 
see step 9 on page 56.

7.	 Optional: To save the current dialog settings as 
a preset for future use on any photo, from the 
Preset menu, choose New Save Options Preset. 
In the dialog, enter a name, then click OK.

8.	 Click Save. A copy of the file appears in the des-
ignated location. The original file, with its current 
settings, remains open in Camera Raw.

➤➤ User-created presets are available on the Preset 
menu. Once you choose a preset, the menu also 
provides Delete [preset name] and Rename 
[preset name] commands.	

➤➤ When you assign a color space and an intent 
to a photo via the Workflow Options dialog, 
those settings display as a soft proof in the main 
Camera Raw dialog, whereas when you choose 
color space and an intent options in the Save 
Options dialog, no soft proof displays.

A In the Save Options dialog, choose Destination, File 
Naming, Format, Color Space, Image Sizing, and Output 
Sharpening settings. 
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A
Action Options dialog, 444
actions

command insertion, 450
command modal controls, 451
command settings, changing, 454
conditional steps, adding, 452–453
defined, 116, 443
deleting, 454
droplets for, 448
duplicating, 449
edit insertion, 450
edit order, 454
editing, 449–454
excluding command from playback, 

445
menu item insertion, 450
modal controls, 451
partial, playing, 445
playback options, 445
playing on batch of images, 446–447
playing on one image, 445
recording, 443–444, 447
renaming, 449
rerecording, 451
ruler units in, 444
sets, 454
Stops, inserting, 449
testing, 453
use suggestions, 447

Actions panel
Button mode, 445
Dialog icon, 451
illustrated, 116, 443
Insert Conditional command, 452
Insert Menu Item command, 450
Insert Stop command, 449
List mode, 443, 445
loading set onto, 454
New Action button, 444, 449, 452
Play button, 445
Playback Options command, 445
Record Again command, 451
Reset Actions option, 454
Save Actions command, 454
uses, 443

Add Anchor tool, 115
Adjustment Brush tool (Camera Raw)

accessing, 71–76
Auto Mask option, 75

correction, editing, 75
defined, 53
Duplicate option, 73
edits, removing, 76
local edits with, 72–74
Mask option, 72, 73, 74, 75, 76
Mask Overlay Color swatch, 75
using, 72–76

adjustment layer presets, 228, 232
adjustment layers

Black & White, 250–252
Brightness/Contrast, 238
clipping, 231
Color Balance, 240–241
creating, 128, 228–229
Curves, 235, 246–249
defined, 126
deleting, 232
editing, 128
effects, hiding, 230
filters and, 379, 380
Gradient Map, 252–253
Hue/Saturation, 242
identifying, 229
layer effects application to, 399
Levels, 235, 236–237, 260
mask, editing, 233
merging, 166, 232
new edits, viewing images without, 

230
options on Properties panel, 128
Photo Filter, 239
presets, 232
settings, 230
Vibrance, 243–245

Adjustments panel
Auto-Select Parameter option, 229
Black & White button, 250
Brightness/Contrast button, 238
buttons, 117, 228
Color Balance button, 240
Curves button, 246
Gradient Map button, 252
Hue/Saturation button, 242, 316
illustrated, 117
Levels button, 236, 260, 399
Photo Filter button, 239
Reset to Adjustment Defaults button, 

230
Vibrance button, 243, 244, 245

View Previous State button, 230
Adobe Bridge. See Bridge
Adobe Color CC web service, 212
Adobe Color Themes panel, 117, 

210–212
Adobe Creative Cloud. See Creative 

Cloud
Adobe Illustrator. See Illustrator, Adobe
Adobe InDesign. See InDesign, Adobe
Adobe RGB color space, 5, 8
Adobe stock images, 272
Adobe Typekit web page, 388
Advanced dialog (Photo Downloader), 

25
Advanced preferences (Bridge), 472
Airbrush tips, 302
alerts, 34, 35
aligning

layers, with Auto-Align Layers 
command, 292

layers, with one another, 289
point type, 384
shapes in same layer, 429
with Smart Guides, 159
type, 394
vector objects, 421

alpha channels, 184, 190, 444
anchor points, 427, 440
ANPA colors, 207
anti-aliasing, 177, 384
Application frame

defined, 97
docking document windows into, 99
illustrated, 97, 98
Mac OS, 98
minimizing, 98
redocking floating panels into, 107
resizing, 98

archiving Creative Cloud files, 497
Art History tool, 115
Artboard tool, 362–363, 365
artboards

adding hand-drawn content to, 363
adding text or shapes to, 363
copying assets into, 365
copying content between, 364
creating in existing document, 362
creating over existing content, 363
creating via New command, 362

Unless noted otherwise, the listings in this index pertain to Photoshop.
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defined, 362
resizing or repositioning, 362

asset files. See image assets
Assign Profile dialog, 12
Auto Resolution dialog, 140
Auto-Align Layers dialog, 292

B
Background

converting into layer, 154
converting layer to, 154
customizing, 104
deleting selection from, 172
duplicating, 306
filling selection on, 172
moving upward on list, 156
new document, choosing for, 15

Background color
choosing, 205, 206, 209
filters that use, 372

Background Eraser tool, 115
baseline shift, 392
Basic blending modes, 214
Basic tab (Camera Raw)

Clipping Warning buttons, 62
color saturation adjustments, 65
contrast adjustments, 62–64
defined, 59, 61
edge contrast adjustments, 65
exposure adjustments, 62–64, 284, 

285
histogram tonal edits, 62
using, 61–65
white balance adjustments, 61

Batch dialog, 446–447
Batch Rename dialog, 43
Bevel effect, 406–407
bit depth, 2, 374
Bitmap mode, 4
Black & White adjustment layer, 

250–252
blemishes, removing, 90–91, 321
blending layers

Blending Options, 356–357
modified with original one, 354
opacity, 355

blending modes
brush, 298
categories, 214
choosing, 214–215
cycling through, 215
fill layer, 216–218

filters and, 380
list of, 214
for scripted patterns, 224

Blending Options
for Layers, 356–357
for Smart Filters, 375

Blur Gallery
applying filters in, 333–341
blurring adjustment, 334
Bokeh feature, 342
defined, 333
Field Blur filter, 333, 334, 335
filter masks, 343
filter pins, 334
Iris Blur filter, 333, 334, 336
Noise options, 341
Path Blur filter, 338–339
selections with filters, 334
Spin Blur filter, 333, 334, 340
Tilt-Shift filter, 333, 334, 337

Blur tool, 115
bokeh options in Blur Gallery, 342
Bridge

cache, exporting, 42
collections, 45–46
Collections panel, 26, 45–46
Content panel, 26, 29, 30, 37
custom, 38
deleting, 38
Favorites panel, 26, 29, 45
file searches, 44
Filter Items by Rating menu, 41
Filter panel, 26
Folders panel, 26, 29
image previews in, 29–32
keywords, 38–39
Keywords panel, 26, 38–39
launching, 23
loupe, 31–32, 470
metadata display, 37
Metadata panel, 26, 39
Metadata placard, 29
navigation controls, 29
Open Recent File menu, 33
opening files from, 33–35
Options for Thumbnail Quality and 

Preview Generation menu, 30
panes and panels, configuring, 36
Photo Downloader, 24–25
Preview panel, 26
Refine menu, 32
resetting, 38

Reveal Recent File or Go to Recent 
Folder menu, 33

Review mode, 32, 40
saving, 38
thumbnails, 29, 30, 36, 40–41, 46
uses, 23
View Content buttons, 37
window customization, 36–37
window features, 26–27
window illustration, 27
workspaces. See workspaces (Bridge)

Brightness/Contrast adjustments, 238
bristle brushes, 304–305
Brush panel

Airbrush tips, 302
Angle option, 298
Brush Pose option, 304
Brush Projection option, 300
Brush Tip Shape option, 298, 301, 302
Color Dynamics option, 300
Create New Brush button, 301
customizing brushes via, 298–301
displaying, 119
Erodible Point tips, 301–302
Hardness option, 299
illustrated, 119, 299
Live Brush Tip Preview button, 301
New Brush button, 132
quick access to, 303
Roundness option, 299
Scattering options, 300
Shape Dynamics option, 300
Size option, 298
Spacing option, 299
Texture option, 300–301
Transfer option, 301
uses, 119

Brush Preset picker, 297, 314–315
brush presets

deleting, 303
identifying types of, 130
loading, 303
managing, 303
modified indication, 303
names, viewing, 307
resetting, 303
saving, 133, 303
settings, 303
tools that use, 130

Brush Presets panel
illustrated, 119
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Live Brush Tip Preview button, 301, 
303

Open Preset Manager button, 135, 
303

quick access to, 303
saving brushes from, 133

brush strokes, recording, 444
Brush tool

Airbrush tip, 302
choosing settings for, 130–131
creating selections with, 191
defined, 114
editing layer masks with, 288
Erodible tip, 301–302
in hiding filter effect, 376
Options bar, 190, 193, 233, 298
painting with, 297–302
reshaping layer masks with, 193, 288
reshaping selections with, 190
in turning photos into drawings, 382

brushes
blending mode, 298
bristle, 304–305
customizing, 132, 298–302
diameter, 131, 286, 314
editing graduated or radial filter 

mask with, 86–87
flow rate, 298
hardness, 130, 131
opacity, 131, 298
roundness, 130
saving, 303
settings, choosing, 130
size, changing, 131, 298
tips, 298–302

Burn tool, 115

C
cache (Bridge), 42
Cache preferences (Bridge), 472
calibration, display, 6
Camera Calibration tab (Camera Raw), 

59
Camera Raw

Adjustment Brush tool, 53, 72–76
advantages to using, 47
Before/After Views menu, 59
Basic tab, 59, 61–65
Camera Calibration tab, 59
Crop tool, 53, 54
default settings, restoring, 59
Detail tab, 59, 68–69

dialog illustration, 51
editing layers in, 52
Effects tab, 59, 82–83
filters, 52
Gamut Warning button, 57
Graduated Filter tool, 53, 86–87
HDR file processing in, 258
high-DPI display support, 51
host selection for, 50
HSL/Grayscale tab, 59, 70–71
Lens Corrections tab, 59, 78–81
luminance, reducing, 68
new merge commands, 94
noise reduction, 48
opening files from, as embedded 

Smart Objects, 273
opening layers in, 52
opening photos into, 51
presets, 92
Presets tab, 59
previews, 48, 53, 59
Radial Filter tool, 88–89
reasons for using, 47–49
Red Eye Removal tool, 53
scrubby-sliders, 59
settings, applying to multiple photos, 

93
settings, removing, 93
settings, save location, 94
settings, saving as preset, 92
settings, synchronizing, 94
Settings menu, 60, 92
shadow clipping, 64
sharpening, 48, 68
Snapshots, 59, 92
Split Toning tab, 59, 77
Spot Removal tool, 53, 90–91
Straighten tool, 53, 55
Targeted Adjustment tool, 66–67, 71
toggling between default settings, 60
tonal redistribution, 48
Tone Curve tab, 59, 66–67
tools, 53
updating, 49
white balance, 60
White Balance tool, 53
workflow options, 56–58
zoom methods, 53

Camera Raw filter, 52, 284
cameras

Adobe RGB color space, 5

capturing tonal values (Camera 
Raw), 48

downloading photos from, 24–25
canvas

area, enlarging with Crop tool, 148
pixels outside of, 263
size, changing, 142
view, rotating, 103

Canvas Size dialog, 142
channels

alpha, 184, 190, 444
core, 2
Curves adjustment layer, 248
defined, 2
document color mode and, 3
spot color, 402

Channels panel
displaying, 2
illustrated, 119
Load Channel as Selection button, 

184
New Spot Channel command, 402
Photoshop color modes and, 2–4
Save Selection as Channel button, 

184
Character panel

Baseline Shift controls, 392
Color swatch, 387
displaying, 120
East Asian Features, 385, 469
Font Family menu, 387
Font Size menu, 390
Font Style menu, 387
illustrated, 120, 383
Kerning menu, 391
Leading controls, 392
Middle Eastern Features, 385, 469
OpenType buttons, 393
resetting, 391
showing, 386
South Asian features, 469
Toggle Typekit Fonts button, 388
Tracking controls, 391

Character Style Options dialog, 396
Character Styles panel

illustrated, 120
Load Character Styles command, 397
Load Default Type Styles command, 

397
New Character Style button, 395
Redefine Character Style by Merging 

Override button, 396
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Save Default Type Styles command, 
397

Clipboard
New dialog and, 16
with Paste command, 262
with Paste Into command, 264
purging, 262
using, 261–264

clipping
adjustments, 231
high-contrast display of, 246
layers, 353–354

clipping masks, 353–354
Clone Source panel, 121, 290–291
Clone Stamp tool, 114, 326–327
cloning, retouching by, 326–327
CMYK Color mode

channels, 3
conversion, 482
defined, 3, 4
output, final corrections in, 227
soft-proofing, 475
working space, 482

CMYK color model, 2, 206
collections (Bridge)

adding to Favorites panel, 45
contents, displaying, 45
creating and using, 45–46
deleting, 45
naming, 45
relinking missing file to, 46
from search results, 44
Smart, creating and editing, 45
standard, adding/removing 

thumbnails, 46
standard, creating, 46
types of, 45

Collections panel (Bridge), 26, 45–46
Color Balance adjustments, 240–241
color corrections

Color Balance adjustment, 240–241
Curves adjustment, 246–249
display calibration and, 227
Hue/Saturation adjustments, 242
Photo Filter adjustments, 239
Vibrance adjustment, 243–245

color depth (Camera Raw), 56
Color Libraries dialog, 205, 207
color management

benefits of using, 5
Color Handling menu, 478, 479
color modes and, 3–4

display calibration, 6
introduction to, 5–6
Output options, 480
Photoshop, benefits of, 479
policies, customizing, 10
settings, 478
turning off for printer, 481
verifying turned off, 481

color modes, document
Bitmap, 4
changing, 374
CMYK Color, 3, 4, 227
conversions, 3
Grayscale, 4
Indexed Color, 4
Lab Color, 4
RGB Color, 3, 4, 227, 473
selecting, 15
Smart Filters and, 374

color noise reduction (Camera Raw), 
68–69

Color panel
choosing colors with, 205
illustrated, 121
out-of-gamut alert, 208

Color Picker
choosing colors with, 205
HUD, 192
opening, 121
out-of-gamut alert, 208
replacement color, 387

color profiles
assigning, 35
changing, 12
converting, 12
defined, 5
mismatch, 10
missing, 10, 35
removing, 12
selecting, 15
for soft proof, 474–475

Color Range command, 178–180
Color Replacement tool

defined, 114
in red-eye removal, 317
using, 314–315

Color Sampler tool, 114
Color Sampler tool (Camera Raw), 53
color settings

choosing, 7, 8
installing, 11
saving, 11

synchronizing, 9
Color Settings dialog

accessing, 7, 8, 10, 11
in color policy customization, 10
color space selection in, 8
Missing Profiles option, 10
Profile Mismatches option, 10
saving color settings in, 11
Settings menu, 8, 482
Working Spaces settings, 8, 482

Color Settings dialog (Bridge), 9
color spaces, 5, 7–8
color themes

creating, 210
deleting, 212
editing, 210, 212
naming, 210
viewing, 211

color-blind viewer design, 218
color(s)

Background, 205, 206
basic methods for choosing, 205–206
blending modes, 214–215
as building blocks, 2
choosing, 205–206
choosing from color libraries, 207
choosing from Swatches panel, 209
choosing with Color Picker, 205, 

206–207
continuous tones, 2
copying as hexadecimals, 213
copying into libraries, 270–271
depth (Camera Raw), 58
desaturating, 244, 245
fill layers, 216
Foreground, 205, 206
layer, assigning, 162, 163
layer mask, 193
process, 207
proofing, 474–475
rendering intents, 475, 478
replacing, 312–313
restoring, selectively, 245
sampling, 205, 213
spot, 206, 207
type, 387

commands (action)
adding, 450
adding modal controls to, 451
deleting, 454
duplicating within/between actions, 

450
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settings, changing, 454
commercial printing, 475, 482
Comparative blending modes, 214
Component blending modes, 214
Conditional Action dialog, 452–453
Content panel (Bridge)

defined, 26
in image display, 29
metadata display in, 37
search results, 44
thumbnail display, 30

Content-Aware fill, 329
Content-Aware Move tool, 114, 

330–331
Content-Aware scaling, 360–361
context menus, 112, 157
continuous tones, 2
contrast

auto adjustment, 235
Brightness/Contrast adjustment, 238
Curves adjustment, 246–247
Levels adjustment, 236–237

contrast adjustments (Camera Raw), 
62–64, 65

Contrast blending modes, 214
Convert Point tool, 115
Convert to Profile dialog, 12
converting

Background to layer, 154
color profiles, 12
layer to Background, 154
layer to grayscale, 250–252
layers to Smart Objects, 272
RGB files to CMYK files, 482
shape layers to pixel layers, 425
type, paragraph to point/point to 

paragraph, 390
vector masks to layer masks, 433

copying
action commands, 450
colors as hexadecimals, 213
imagery to new layer, 263
layer effects, 414
layer masks, 196
layer settings, 263
layer styles, 417
layers, 167
layers, Smart Guides and, 294
pasting, 262
path listing, 441
selection borders, 173
selections, 262

shapes, 429
Smart Filters, 375
Smart Objects, 277
stroke and fill attributes on shapes, 

425
vector masks, 432

Count tool, 114
Creative Cloud

application adherence to ICC profiles, 
5

archiving in, 497
Assets page, 492
desktop app

launching Photoshop via, 1
viewing Asset files via, 491, 496

downloading settings from, 496
Extract view, 492, 493
individual file management, 498
information, viewing, 496
managing files via, 496–498
missing fonts and, 34
preferences, 461
sharing, renaming, moving, or 

archiving files via, 497
signing out of, 498
syncing fonts and, 388
syncing of assets, 117
syncing Photoshop settings via, 

495–496
syncing presets with, 132
syncing PSD files/folders to, 491
uploading files to, 496
uploading settings to, 495–496

Creative Cloud extract feature
file preparation for, 490
working with, 492–493

Creative Cloud Libraries
asset updating, 272
asset use in documents, 271
assets creation, 270
copying content into, 270
creating, 270
moving elements via, 270–272
sharing, 271
uses of, 125
viewing, 271

Creative Profile widget, 496
crop box

choosing options for, 144
cropping to, 146
guide lines within, 144
repositioning images within, 144

resizing, 143, 146
restoring, 143
selection in defining, 147

Crop tool
Camera Raw, 53, 54
crop box reset, 144
cropping image, 143
cropping multiple images, 146–148
cropping to aspect ratio, 146
cropping to crop box, 146
cropping to size and resolution, 146
defined, 114
enlarging canvas area, 148
overlay options, 144
preview options, 144
recording use of, 447
saving settings as preset, 147
shield options, 144
sticky settings, 147
straightening images with, 149

cropping
to aspect ratio, 146
to crop box, 146
manually, 143
nondestructive, 144
photos (Camera Raw), 54
to specific size and resolution, 146
trim areas, 148

.csf files, 11
Cursors preferences, 113, 321, 466
Curves adjustment layer

applying, 246–249
color correction with, 248
in darkening midtones, 230
options, 246–247
Targeted Adjustment tool, 246, 248
tonal adjustments with, 246–247
See also adjustment layers

Curves Display Options dialog, 246
Custom Shape tool, 115, 422
Customize Proof Condition dialog, 474

D
Darken blending mode, 214, 324–325
Dehaze (Camera Raw), 84–85
Delete Anchor tool, 115
Delete Workspace dialog, 109
desaturation, 244–245
Design Space

defined, 98, 499
illustrated, 499–500
previewing, 499–500



506    Index

switching to, 116
Detail tab (Camera Raw), 59, 68–69
DIC Color Guide, 207
Diffuse Glow filter, 379
dimensions

document, 137–141
selection, 170
Web output, 13, 16

Direct Selection tool, 115, 428, 440
displays, calibrating, 6, 227
distortion

geometric, 78–81
layer, 358–359
Liquify filter, 366–368
Warp, 370
See also transformations

distributing layers, 289
DNG files, 95
docks, panel

collapsing, 106
creating, 107
floating, 107
hidden, displaying, 105
reconfiguring, 106–107

document windows
displaying one image in two, 100
docking, 99
floating, 99
multiple, rotating among, 102
multiple, scrolling/zooming in, 103
repositioning images in, 102
resizing, 100
right-clicking in, 112
selecting layers or layer groups in, 

155, 268
Status bar, 21
tiling, 100

documents
blank, creating, 15–16
closing, 22
creating artboards in, 362
creating from history states, 204
creating from layers, 268
creating from thumbnails, 268
dimensions, 21, 137–141
dragging files into, as Smart Objects, 

274–275
flattened, 168
information, getting quickly, 21
open, displaying specs of, 16
opening as tabs, 99
pixel scale ratio, 21

presets, creating, 16
profiles, 21
resolution, 137–141
reverting to last version, 18
saving, 18–20
size, 21
Status bar, 21
type styles, loading, 397

Dodge tool, 115
downloading photos (Bridge), 24–25
drag-copying

layers, 268–269
selections, 265–267

drawings, changing photos into, 382
Drop Shadow layer effect

in adding depth, 381
applying, 408–409
in rusted metal type, 396
transforming, 409

droplets for actions, 448
Duplicate Layer dialog, 268
duplicating

actions, 449
Background, 306
embedded Smart Objects, 277
layers and layer groups, 153
See also copying

E
Edit menu

Assign Profile command, 12
Auto-Align Layers command, 292
Clear command, 264
Color Settings command, 7, 8, 10, 

313, 475, 482
Content-Aware Scale command, 

360, 361
Convert to Profile command, 12
Copy command, 262, 264
Copy Merged command, 262, 264
Cut command, 172, 262
Define Custom Shape command, 

132, 439
Define Pattern command, 132, 222
Fill command, 133, 216, 224, 233, 329
Free Transform command, 358, 359
Free Transform Path command, 358, 

441
Menus command, 108
Paste command, 262, 439
Paste Special command, 262, 264
Presets command, 134, 135
Purge command, 200, 262

Transform Path submenu, 441
Transform submenu

Distort command, 400, 409
Flip commands, 150
Perspective command, 400
Rotate commands, 150
Warp command, 370

Edit menu (Bridge)
Color Settings command, 9
Develop Settings command, 93
Find command, 44, 45

Edit Smart Collection dialog, 45
editable type layers

creating, 384–385
defined, 126
fading, 397
filling, 398
merging, 166
preserving, 400
See also type

Effects tab (Camera Raw)
Clarity option, 85
defined, 59
Dehaze option, 84–85
grain texture application, 82
vignette application, 83

Ellipse tool, 115
Elliptical Marquee tool

in creating selections, 170
defined, 114
in deselection, 172
fixed ratio/dimensions selection, 170
in frame-shaped selections, 181
Options bar, 170

Embedded Profile Mismatch alert 
dialog, 35

embedded Smart Objects
converting layers in Photoshop files 

to, 272
converting to linked, 283
creating, 272–275
duplicates, creating, 277
duplicates, editing, 277–278
editing, 276
opening files as, 273
opening files from Camera Raw as, 

273
pasting Adobe Illustrator art as, 274
placing/dragging files as, 274–275
replacing, 279
See also Smart Objects

Emboss layer effect, 406–407



Index    507 

Enhance Brightness and Contrast 
algorithm, 237

Eraser tool, 115, 308
Erodible Point tips, 301–302
Essential workspace (Bridge), 28
Every-Line Composer, 394
Export As command, 141
Export As dialog, 488
Export panel, 489
Export preferences, 463
Export/Import Presets dialog, 134
exporting

Bridge cache, 42
color swatches, 209
image assets from layers, 487–489
layers/documents, 487
layers/documents via Export As, 488
layers/documents via Quick Export, 

489
preset libraries, 134

exposure correction (Camera Raw)
adjustments, 62–64
Basic tab, 284, 285

exposures, combining, 284–286
Extract for Devices widget, 494
extracting image assets

Creative Cloud Extract feature and, 
492–493

multiple scales, 494
PSD file preparation, 490
PSD file/folder syncing, 491

Eyedropper tool, 114, 213
eyes, whitening, 316

F
Favorites panel (Bridge), 26, 29, 45
Field Blur filter

blurring control, 334
defined, 333
mask, using, 343
pins, 334, 335, 342
using, 335

file formats, 18–20
File Handling preferences, 20, 462–463
File menu

Automate submenu, 448
Browse in Bridge command, 9
Close command, 22
Exit/Quit command, 22
Export submenu, 488, 489
New command, 15, 16, 362
New Dialog command, 152
Open as Smart Object command, 273

Open command, 33, 484
Open Recent command, 33
Package command, 473
Place command, 484, 485
Place Embedded command, 274
Place Linked command, 280
Print command, 476
Revert command, 18, 199
Save As command, 12, 18, 20, 141, 

168, 482, 485
Save command, 18
Scripts submenu, 415

File menu (Bridge), 28, 33
File Type Associations preferences 

(Bridge), 472
files

archiving (Creative Cloud), 497
dragging into documents as Smart 

Objects, 274–275
8-bit, 17
getting into Illustrator, 484–485
getting into InDesign, 484, 485
managing via Creative Cloud, 

496–498
opening as embedded Smart Object, 

273
opening from Camera Raw as 

embedded Smart Object, 273
placing into Photoshop as Smart 

Objects, 274–275
preparing for commercial printing, 

482
resampling, 137
resolution, 13–14
saving in PDF format, 483
16-bit, 17
32-bit, 17, 21
versions, saving, 20

files (Bridge)
assigning keywords to, 38–39
batch-renaming, 43
cache, 42
copying, 42
deleting, 42
managing, 38–39, 42
moving, 42
opening, 33–35
quick search, 44
renaming, 42
reopening, 33
searching for, 44

files (Camera Raw)
JPEG files versus raw files, 47, 49

opening into Photoshop, 94
previewing, 48
saving, 94
TIFF files versus, 47, 49
workflow options for, 56–57

Fill dialog, 224, 226, 329
fill layers

blending mode, 216–218
color, changing, 216
defined, 126
Gradient, 217–218
opacity, 216–218
Pattern, 218
with scripted patterns, 222–226
Solid Color, 186, 216

filmstrip panel menu (Camera Raw), 94
Filmstrip workspace (Bridge), 28
Filter Gallery

accessing, 372, 374
dialog illustration, 373
previews, hiding/showing, 372
using, 372–373

filter masks, 376, 378
Filter menu

Blur Gallery submenu, 333, 338
Blur submenu, 323, 324
Brush Strokes submenu, 419
Camera Raw Filter command, 52
Convert for Smart Filters command, 

374
Filter Gallery command, 372, 374
Liquify command, 366
Other submenu, 378
Render submenu, 223
Sharpen submenu

Shake Reduction command, 349
Smart Sharpen command, 344
Unsharp Mask command, 347

Stylize submenu, 380, 382
Filter panel (Bridge), 26, 41
filters

adjustment layers and, 379, 380
applying, 371–373
applying as Smart Filter, 374
applying via Filter Gallery, 372–373
blending modes and, 380
Diffuse Glow, 379
effects, replacing, 372
effects, stacking position, 372
Field Blur, 333, 334, 335, 342, 343
Find Edges, 380
Foreground/Background colors, 372
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Gaussian Blur, 324–325
Iris Blur, 333, 334, 336, 343
last used, reopening, 372
Liquify, 321, 366–369
Maximum, 378
memory problems and, 376
Minimum, 378, 380
Path Blur, 338–339, 343
Picture Frame, 223
preferences, 468
preview feature, 373
reapplying, 372
Render, 223
Shake Reduction, 349–352
Smart Sharpen, 344–346
Spatter, 419
Spin blur, 333, 334, 340, 343
Surface Blur, 323
techniques for using, 379–381
Texturizer, 381
Tilt-Shift, 333, 334, 337, 343
unavailable, 371
Unsharp Mask, 347–348
uses, 371

Find dialog (Bridge), 44
Find Edges filter, 380
flattening

layer effects, 415
layers, 168

flipping
clone source overlay, 291
layers, 150

FOCOLTONE colors, 207
Focus Area Add tool, 182, 183
Focus Area dialog, 182–183
Focus Area Subtract tool, 183
folders (Bridge), 29, 42
Folders panel (Bridge), 26, 29
fonts

family, changing, 387–388
missing fonts alert, 34
size, changing, 390
style, changing, 387–388
Typekit, 34, 388–389
vector outlines, 385

Foreground color
choosing, 205, 206, 209
filters that use, 372

Freeform Pen tool
defined, 115
in drawing paths, 431
using, 434

Full screen mode, 104

G
gamma, calibration, 6
Gaussian Blur filter, 324–325
General preferences

Always Create Smart Objects When 
Placing, 274, 456

Export Clipboard, 261–262, 456
HUD color picker, 456
illustrated, 456
Image Interpolation, 456
Options, 456
Reset All Warning Dialogs, 456
Resize Image During Place, 274, 280, 

456
General preferences (Bridge), 470
Generator preferences, 468
geometric distortion, correcting 

(Camera Raw), 78–81
GIF file format, 487
glyphs, 393
Glyphs panel, 122, 393
Golden Ratio, 144
Golden Spiral, 145
Gradient Editor dialog

illustrated, 220
opening, 219, 252
in tinting images, 252–253

Gradient Fill dialog, 133, 217, 220
Gradient fill layers

applying gradients via, 220
creating, 217–218
settings, editing, 218

Gradient Map adjustments, 252–253
Gradient Overlay layer effect, 410–411
Gradient tool

applying gradients via, 221
defined, 115
editing layer mask via, 287–288
filter effect, 376, 378
Gradient thumbnails, 219
Options bar, 287

gradients
applying via fill layer, 217–218
applying via Gradient Overlay effect, 

410–411
applying via Gradient tool, 221
creating, 132
defined, 217
effects, complex, 220
filter mask, 378
layer mask, 287–288

loading, 217
presets, 219–220
repositioning, 411
resetting to default position, 411
saving, 133
scaling, 411

Graduated Filter tool (Camera Raw), 
53, 86–87

grayscale, 250–252
Grayscale mode, 4
grid preferences, 468
Guides, Grid & Slices preferences, 

294, 468

H
hair selection, 186–189
Hand tool

Camera Raw, 53
defined, 116
in repositioning images, 102
temporary, 102

HDR (High Dynamic Range) images
Merge to HDR Pro command, 

254–258
outputting to screen or print, 259
processing in Camera Raw, 258
producing, 254–259
shooting photos for composite, 254

HDR Merge Preview dialog, 258
Healing Brush tool

defined, 114
hot spot removal, 320
using, 318–320
wrinkles, softening, 318, 319

highlights
Color Balance adjustment, 241
with Levels adjustment, 236
lightening, 247

Histogram panel, 122, 234–235
History Brush tool

defined, 115
History panel with, 123
using, 309–310

History Log preferences, 460
History Options dialog, 198, 201
History panel

defined, 197
Delete Current State button, 200
History Brush tool with, 123
illustrated, 123
linear mode, 197, 198, 199
New Document from Current State 

button, 204
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New Snapshot option, 202
nonlinear mode, 198, 199
number of states, 198
options, 197–198

history states
changing, 199
clearing, 200
deleting, 123, 200
document creation from, 204
number of, 198
purging, 200
restacking, 199
snapshots, 201–203

HKS colors, 207
Horizontal Type Mask tool, 115
Horizontal Type tool

in changing font size, 390
creating type with, 384–385
defined, 115
recoloring type with, 387
selecting type with, 386

HSB model, 208
HSL/Grayscale tab (Camera Raw), 59, 

70–71
HUD color picker, 206
Hue/Saturation adjustments

applying, 242
for increasing saturation, 231
range, setting, 243
Targeted Adjustment tool, 242

I
Illustrator, Adobe

art, pasting into Photoshop, 274
art, path/shape creation from, 439
opening/placing Photoshop Layer 

into, 485
Photoshop to, 484

image assets
copying into artboards, 365
creating, 270
exporting from layers, 487–489
extracting from layers, 487–489
updating, 272
use in documents, 271

Image menu
Adjustments submenu

applying adjustment 
commands via, 374

command effects, 228
Replace Color command, 312

Canvas Size command, 142
Image Rotation commands, 103, 150

Image Size command, 262
Mode submenu, 3
Trim command, 148

Image Size dialog
Auto Resolution option, 140
downsampling for print size, 141
downsampling for Web output, 141
image resolution, changing for print 

output, 138
image upscaling for print output, 139
settings, restoring, 138

images
colors as building block of, 2
cropping, 143–145
downsampling, 141
flipping, 150
HDR, 254–259
for layer effects, 405
maximum size, 13
moving, in document window, 102
multichannel, 4
multiple, cropping, 146–148
playing actions on, 445, 446–447
previews (Bridge), 29–32
print resolution, 13
repositioning, in document window, 

102
reshaping areas in, 321
resizing (Camera Raw), 58, 80
resolution, 138, 139
rotating, 150
rotating (Camera Raw), 80
scaling (Camera Raw), 80
straightening, 149
tinting, 252–253
trimming areas around, 148
upscaling for print output, 139
Web resolution, 13

Import Options dialog, 485
importing

preset libraries, 134
type as Smart Object, 385

InDesign, Adobe, 484, 485
Indexed Color mode, 4
Info panel, 124
inkjet printing

outputting files for, 476–482
printer driver settings, 476–477
proofing documents for, 474
RGB Color mode for, 473

Inner Glow layer effect, 396
Inner Shadow layer effect, 396, 408

Insert Menu Item dialog, 450
Interface preferences, 104, 112, 365, 

457
inverting

layer masks, 193
selections, 177

Iris Blur filter
blurring control, 334
defined, 333
mask, using, 343
using, 336

isolating layers, 164
isolation mode, exiting, 165

J
JPEG files

exporting, 487
importing into Photoshop as 

embedded Smart Objects, 
273–274

opening, 33
opening into Camera Raw, 50–51
previously edited, opening (Camera 

Raw), 50
raw files versus (Camera Raw), 47, 49
saving, 20
saving raw files as (Camera Raw), 

95–96

K
kerning type, 391
Keyword preferences (Bridge), 472
keywords (Bridge), 38–39
Keywords panel (Bridge), 26, 38–39

L
Lab Color mode, 4
labels, thumbnail (Bridge), 40
Labels preferences (Bridge), 472
Lasso tool, 114, 171–172
launching

Bridge, 23
Photoshop, 1

layer comps, 125
Layer Comps panel, 125
layer effects

applying, 403–404, 405
applying to adjustment layer, 399
Bevel, 406–407
copying, 414
default settings, 405
Drop Shadow, 396, 408–409
Emboss, 406–407
essentials, 403–405
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flattening, 415
Gradient Overlay, 410–411
hiding/showing, 404
imagery selection, 405
Inner Glow, 396
Inner Shadow, 396, 408
live aspect of, 414
moving, 414
multiple, applying, 418–419
Outer Glow, 396, 420
Pattern Overlay, 411
Pillow Emboss, 407
rasterizing, 419
removing, 414
Satin, 411
scaling, 411
settings, changing, 404
settings, saving, 407
Stroke, 410
types of, 403

layer groups
in clipping mask, 354
collapsing, 157
creating, 156–157
deleting, 158
dragging up/down, 156
duplicating, 153
hiding/showing, 324
locking, 161
moving layers out of, 157
opacity, changing, 160
renaming, 154
selecting, 155, 268
ungrouping, 158

layer masks
adding via Layers panel, 192
adjustment, editing, 233
applying, 196
black versus white areas in, 286
blending exposures via, 286
color, changing, 193
converting vector masks to, 433
copying, 196
creating, 192
defined, 192
deleting, 196
density adjustment, 194
disabling, 196
edges, refining, 195
editing, 193–195
editing on adjustment layers, 233
editing with Brush tool, 288

enabling, 196
feather adjustment, 194
gradients in, 287–288
loading, 196
moving, 196
outputting selections as, 192
repositioning, 195
reshaping, 193
shortcuts for, 233
working with, 195–196

Layer Style dialog
Angle setting, 404
Bevel and Emboss, 406–407
Blending Options, 356–357
Contour presets, 404
Drop Shadow, 408–409
Gradient Overlay, 410–411
illustrated, 404, 412
Inner Shadow, 408
for layer styles, 416
menus and buttons at bottom, 

412–413
opening, 356, 403, 405
Pattern Overlay, 411
Stroke, 410

layer styles
applying, 416
copying, 417
copying into CC Library, 270–271
creating, 132, 417
defined, 129
with Layer Styles dialog, 416
rasterizing, 419
removing, 416
saving, 417
scaling, 140

layers
aligning, with one another, 289
aligning, with Smart Guides, 159
blank, adding, 152
blending modes, 215, 355–357
blending options, 356
clipping masks, 353–354
color-coding, 161
content, repositioning, 195
converting to Smart Object, 272
copying and merging, 167
creating, 152–154
deleting, 158
desaturating, 244, 245
deselecting, 155
distributing, 289

document creation from, 268
drag-copying, between files (Layers 

panel), 268–269
drag-copying between files (Move 

tool), 266–267
dragging from inside, 266
duplicating, 153
edges, fading via gradient in layer 

mask, 287–288
editable type, 126, 384–385
editing in Camera Raw, 52
exporting image assets from, 

487–489
extracting image assets from, 

490–494
file formats that support, 374
file size and, 168
fill, 126, 216–218
Fill percentage, 415
filling with Render filter, 223
filling with scripted pattern, 223–224
filtering, 162–163
flattening, 168
flipping, 150
hiding, 151, 158
image, 126
isolating, 164–165
locking, 161
merging, 166
moving out of groups, 157
multiple, selecting, 155
naming, 153
nontransparent areas, selecting, 169
nudging one pixel at a time, 159
opacity, changing, 160
opening in Camera Raw, 52
pixel selection conversion into, 153
releasing from isolation, 164
renaming, 152, 154
repositioning, 159
restacking, 156
rotating, 150
scaling, 268
screening back, 260
selecting, 155, 169
selecting, in document window, 268
shape, 126, 421–439
straightening, 149
visible, merging, 167
warping, 370
See also adjustment layers
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Layers panel
Add Layer Mask button, 286, 287, 

292, 323, 382
Add Layer Style menu, 403
Add Vector Mask button, 432
Advanced Blending badge, 357
Apply Layer Mask option, 196
Artboard from Layers option, 363
Background, 151, 153, 154
blending modes, 215
Blending Options, 375
Collapse All Groups command, 157
context menus, 157
Convert to Smart Object command, 

272
Create Fill/Adjustment Layer menu, 

216, 217, 228
Delete Layer button, 232, 414
Delete Layer Mask option, 196
Delete Vector Mask option, 196
display options, 161
drag-copying layers with, 268–269
Duplicate Layer command, 167
Fill setting, 415
Filter Type menu, 162, 165
filtering Smart object listings on, 283
Flatten Image command, 168
illustrated, 126
isolation mode, exiting, 165
Layer Filtering On/Off button, 162, 

165
layer mask creation with, 192
listings, filtering, 162–163
Lock Transparent Pixels button, 160, 

298, 310
Merge Down command, 232
Merge Layers command, 232
Merge Visible command, 167
New Artboard command, 362
New Group button, 157
New Group from Layers command, 

156
New Layer button, 152, 153
options, 161
selecting layers via, 155
thumbnail options, 161
uses, 126

leading, 392
Lens Corrections tab (Camera Raw)

defined, 78
edits, applying to multiple photos, 81
Manual settings, 79–81
for multiple photos, 81

preset corrections, 79
Profile settings, 78
using, 78–81

Levels adjustment layer
illustrated effects, 236
mask, 399
screening back layers with, 260
settings, applying, 236
tonal values correction with, 236–237
See also adjustment layers

Libraries panel, 125, 270–272
Light Table workspace (Bridge), 28
Lighten blending mode, 214, 324–325
Line tool, 115
linked Smart Objects

converting to embedded, 283
creating, 280
editing contents of, 281
Layer Comps menu, 280
missing, alert for, 35
missing, getting data on, 282
packaging, 473
relinking, 35, 282
replacing, 279
updating, 282
working with, 281–283
See also Smart Objects

Liquify filter
applying to Smart Objects, 368
distortion tools, 366–368
edits, removing, 368
protecting image areas from, 366
quick access to tools, 368
Reconstruct Options, 368
for retouching, 321, 369
Tool Options, 366–367

locking
layers or layer groups, 161
transparent pixels, 160

loupe (Bridge), 31, 32, 351, 470
luminance (Camera Raw), 68–69

M
Mac OS

Application frame, 98
droplet usability in, 448
launching Bridge in, 23
launching photoshop in, 1
quitting Photoshop in, 22
Save As dialog box, 19

Magic Eraser tool, 115
Magic Wand tool, 114, 176–177

Magnetic Lasso tool, 114
masks

with Adjustment Brush tool (Camera 
Raw), 72–76

Blur Gallery filter, 343
clipping, 353–354
creating, 192
density, 194
editing, 193–195
feathering, 194
layers, 192–196
options on Properties panel, 128, 

194–195
partial, 190
refining edges of, 195
storing selections as, 191
zooming in on, 190
See also filter masks; layer masks; 

Quick Masks; vector masks
Maximum filter, 378
Merge Result dialog, 258
Merge to HDR Pro dialog

Advanced tab, 256
Curves tab, 257
in making images look surreal, 257
opening, 254
Tones and Detail, 254
using, 254–258

merging
adjustment layers, 232
in Camera Raw, 94
filmstrip panel menu, 94
layers, 166
photos into panorama, 292–293
visible layers, 167

metadata (Bridge), 37
Metadata panel (Bridge), 26, 39
Metadata placard (Bridge), 29
Metadata preferences (Bridge), 471
midtones

adjusting separately, 357
Color Balance adjustment, 241
darkening, 229, 230
with Levels adjustment, 236
lightening, 247, 260
reducing blue and green in, 249

Minimum filter, 378, 380
Missing Fonts dialog, 34
Missing Profile alert dialog, 35
Mixer Brush tool

Airbrush tip, 302
bristle brush creation, 304
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bristle brush paint options, 305
cleaning bristle brushes, 305
defined, 114
Erodible tip, 302
photos into paintings, 306–308
using, 304–306

Monitor Color preset, 8
Move tool

in adding isolated layers, 165
drag-copying with, 265, 266–267
in layer selection, 155
in moving selection contents, 173
Options bar, 263, 268, 289
in repositioning layer mask, 195
in repositioning layers, 159
scaling type with, 390
transformations with, 358–359

moving
with Content-Aware Move tool, 

330–331
layer effects, 414
layer masks, 196
layers, Smart Guides and, 294
selection borders or contents, 173
vector masks, 432

multiple effect settings, 412–413

N
Navigator panel

functions, 127
illustrated, 102, 127
in repositioning, 102
in zooming, 102

New (document) dialog, 15–16
New Actions dialog, 444
New Artboard dialog, 362
New Crop Preset dialog, 147
New Document Preset dialog, 16
New Guide Layout dialog, 296
New Layer dialog, 154
New Preset dialog (Camera Raw), 92
New Snapshot dialog, 202
New Spot Channel dialog, 402
New Style dialog, 417
New Tool Preset dialog, 136
New Workspace dialog, 38, 108
noise reduction (Camera Raw), 48
North America Newspaper preset, 8
North America Web/Internet preset, 8
North American General Purpose 2 

preset, 8

North American Prepress 2 preset, 7, 
8, 9, 10

Note tool, 114

O
opacity

blending layers, 355
brush, 298
changing, layer or layer group, 160
duplicate layer, 382
fill layer, 216–218
fill percentage, 415
overlay, 410, 411
shadow, 408
Smart Object, 377
stops, 219
tool, 214

Open as Smart Object dialog, 273
OpenGL, enabling, 97
OpenType characters, 393
Options bar

accessing, 110
Artboard tool, 363
Brush tool, 190, 193, 233, 298
Character panel, 387
Clone Source tool, 290
Clone Stamp tool, 326–327
Color Replacement tool, 314, 317
Content-Aware Move tool, 330
Content-Aware Scale command, 360
Crop tool, 143, 144, 148
Elliptical Marquee tool, 170
Eraser tool, 308
Eyedropper tool, 213
features, changing, 110
Free Transform command, 359
Freeform Pen tool, 431, 434
Gradient tool, 287
Healing Brush tool, 318
History Brush tool, 309–310
Horizontal Type tool, 384, 387, 390
Magic Wand tool, 176
Mixer Brush tool, 110, 304, 305, 306
Move tool, 155, 263, 268, 289
numerical values, changing, 123
Patch tool, 322, 332
Path Selection tool, 423, 428
Pen tool, 431, 436, 437, 439, 440
Quick Selection tool, 174
Rectangular Marquee tool, 170
Red Eye tool, 317
Sharpen tool, 352
Spot Healing Brush tool, 321

Toggle Brush Panel button, 107
Tool Preset picker, 113
values, canceling, 110
Vertical Type tool, 384, 387, 390
Warp command, 370
Workspace menu, 104, 108, 109, 110

orientation, type, 392
Outer Glow layer effect, 396, 420
out-of-gamut alert, 208

P
Paint Bucket tool, 115
paintings, 306–308, 381
panel

Actions, 116, 443–454
Adjustments, 117, 227–232
Adobe Color Themes, 117, 210–212
Brush, 119, 298–302
Brush Presets, 119, 303
Channels, 2–4, 119
Character, 120, 383, 385, 391–393
Character Styles, 120, 394, 397
Clone Source, 121, 290–291
Color, 121, 208
Glyphs, 122
Histogram, 122, 234–235
History, 123, 197–204
Info, 124
Layer Comps, 125
Layers, 126, 151–168, 268–269, 

286–287, 292
Libraries, 125
Navigator, 102, 127
Paragraph, 127, 385, 394
Paragraph Styles, 127, 394, 397
Paths, 127, 434–435, 439–442
Properties, 128, 193, 196, 228–232
Styles, 129, 416–417
Swatches, 129, 209
Timeline, 129
Tool Presets, 129
Tools, 113–116, 190

panel groups
closing, 106
floating, 107
moving, 107
reconfiguring, 106–107

panels
closing, 106
configuring, 105–107
deleting presets from, 132
hidden docks, displaying, 105
hiding, 105, 106
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icons, 112
maximizing/minimizing, 106
moving, 107
opening, 105
preset management via, 132–134
redocking into Application frame, 

107
restoring default presets to, 134
showing, 105, 106
widening or narrowing, 107

panels (Bridge)
Collections, 26
configuring manually, 36
Content, 26, 29, 37, 44
displaying/hiding, 36
Favorites, 26, 29
Filter, 26, 41
Folders, 26, 29
Keywords, 26, 38–39
Metadata, 26
Preview, 26, 29

Panorama Merge Preview dialog, 
292–293

panoramas, 292–293
PANTONE PLUS (+) colors, 207
Paragraph panel

alignment buttons, 394
controls, 394
East Asian Features, 385, 469
functions, 127
illustrated, 127
justification buttons, 394
Middle Eastern Features, 385, 469
South Asian features, 469

Paragraph Styles panel
Clear Overrides button, 395
functions, 127
illustrated, 127
Load Default Type Styles command, 

397
Load Paragraph Styles command, 397
New Paragraph Style button, 395
Redefine Paragraph Style by Merging 

Override button, 396
Save Default Type Styles command, 

397
paragraph type

converting to point type, 390
creating, 384
transforming, 398

Paste Camera Raw Settings dialog, 93
Paste dialog, 274

pasting
files as Smart Objects, 274
Illustrator art into Photoshop, 274
refining selections after, 267
into selections, 264
selections, 262

Patch tool
defined, 114
removing image elements with, 332
retouching with, 322

Path Blur filter
applying, 338–339
blurring elimination, 339
mask, using, 343
strobe effect, 340

Path Selection tool
in aligning shapes, 429
defined, 115
Options bar, 423, 428
in uniting shapes, 429
with vector masks, 430, 433

paths
applying fill/stroke colors to, 442
combining, 441
copying, 441
creating from Illustrator, 439
creating from shape layer, 439
creating vector masks from, 430
curved, drawing, 437
deleting, 441
hiding/displaying, 435
loading as selection, 442
nonsmooth curve, drawing, 438
preserving, choosing file formats 

for, 441
producing shapes from, 439
repositioning, 435
selecting/deselecting, 435
storing and accessing, 127
straight-sided, drawing, 436
temporary (Work Paths), 434, 435
transforming, 441
working with, 441–442

Paths panel
Delete Path button, 441
Fill Path with Foreground button, 442
illustrated, 127
Load Path as Selection button, 441, 

442
Make Work Path from Selection 

button, 439, 441
path listings, restacking, 441

Stroke Path with Brush button, 442
working with, 434–435

Pattern fill layers, 218
Pattern Overlay layer effect, 411
Pattern picker, 300
Pattern Stamp tool, 114
patterns

custom, 222, 224
hiding areas of, 224
repositioning, 411
saving, 224
scaling, 411
scripted, 222–226

PDF format, 18, 19, 483
Pen tool

in adding/deleting points, 440
combining skills, 439
defined, 115
in drawing curved paths/shapes, 437
in drawing nonsmooth curves, 438
in drawing paths, 431
in drawing straight-sided paths/

shapes, 436
Pencil tool, 114
Performance preferences

Graphics Processor Settings, 464
History & Cache, 198, 464
illustrated, 464
Memory Usage, 464
Use Graphics Processor, 97, 102, 103, 

297
perspective, 146, 359
Perspective Crop tool, 114, 146
Photo Downloader (Bridge), 24–25
Photo Filter adjustments, 239
photos

downloading (Bridge), 24–25
merging into panorama, 292–293
sampling colors from, 306
shooting for HDR composite, 254
shooting for panorama, 293
turning into paintings, 306–308
turning into tinted drawing, 382

photos (Camera Raw)
archiving as DNG files, 95
cropping, 54
cycling through, 94
embedded Smart Object, editing, 

276
grayscale, color tint application, 77
haze in, 84–85
lens correction synchronization, 81
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opening into Camera Raw, 50
opening into photoshop, 95
preferences, setting, 50
resolution, 56, 58
rotating, 80
scaling, 80
sharpening, 56, 68
straightening, 55
stretching, 80
updating, 50
vignette application to, 83
workflow settings for, 58

Photoshop
exiting/quitting, 22
getting to quickly (Bridge), 33
launching, 1

Photoshop Import Options dialog, 485
Photoshop Print Settings dialog

illustrated, 476, 479, 480
PostScript Options category, 480
Printing Marks options, 480
settings, 478–480

pickers
deleting presets from, 132
loading presets onto, 133, 135
preset management via, 132–134
restoring default presets to, 134
saving presets on, 133
See also specific pickers

Picture Frame filter, 223
Pillow Emboss layer effect, 407
pixels

adding to canvas, 142
erasing, 308
maximum image size in, 13
outside canvas, 263
pasted, 262
rasterizing type into, 400–401
selection, turning into layer, 153
shadow, in histogram, 235
transparent, locking, 160

Place Along Path dialog, 225
Place dialog, 279, 484
Playback preferences (Bridge), 471
Plug-ins preferences, 468–469
PNG file format, 487
point type, 384, 390
Polygon tool, 115
Polygonal Lasso tool, 114, 171
pop-up sliders, 123
PostScript printing options, 480

preferences, 455–472
Cursors, 113, 321, 466
Export, 463
File Handling, 20, 50, 462–463
General, 101, 131, 261–262, 280, 

421, 456
Guides, Grid & Slices, 294, 468
History Log, 460
Interface, 104, 112, 365, 457
opening, 455
Performance, 97, 98, 103, 198, 297, 

464
Plug-ins, 468–469
resetting, 455
Scratch Disks, 465
Sync Settings, 461, 495–496
Technology Previews, 469
Tools, 102, 459–460
Transparency & Gamut, 160, 466
Type, 385, 469
Units & Rulers, 16, 467
Workspace, 99, 106, 109, 458

preferences (Bridge), 470–472
Advanced, 472
Cache, 42, 472
Camera Raw, 50
File Type Associations, 472
General, 50, 470
Keywords, 472
Labels, 472
Metadata, 471
opening, 455
Playback, 471
resetting, 455
Startup Scripts, 472
Thumbnails, 37, 471

preferences (Camera Raw), 50
preset libraries, 133–134
Preset Manager, 135, 303
presets

adjustment layer, 232
brush, 130, 303
Color Range, 179
color settings, 7
creating, 16, 132
default, restoring, 134
deleting, 16, 132, 135
document, 16
exporting, 134
gradient, 219
importing, 134
loading, 135

naming, 16
renaming, 135
saving, 16, 135
tools, 136
unsaved, storage, 132

presets (Camera Raw), 92
Presets tab (Camera Raw), 59
Preview panel (Bridge), 26, 29
Preview workspace (Bridge), 28
previews (Bridge)

comparing, 30
full-screen, 30
quality options, 30
in Review mode, 32
thumbnail, 29

previews (Camera Raw)
histogram clipping warnings, 62
positions, swapping, 59
raw photos, 48
Threshold, 64
zooming in, 53

previews (filter), 372, 373
Print dialog

accessing, 476
Color Management settings, 481
illustrated, 477
printer driver settings, 476–477

print output
commercial, 475, 482
downsampling photos for, 141
file resolution, 14, 16, 138
quasi hard proof, 480
scaling, 478
soft proofing for, 474–475
upscaling images for, 139

printers
color management, turning off and, 

481
driver settings, 476–477
profiles, acquiring, 11
rendering intents and, 475

process colors, 207
profiles

color, 5, 12
document, 21
printer, 11

proofing colors, 474–475
Properties panel

adjustment layer options, 128
Apply Mask button, 196
Auto-Select Parameter option, 229
Black & White controls, 250, 251, 252
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Brightness/Contrast controls, 238
Clip to Layer button, 231
Color Balance settings, 240, 241
Curves Display Options, 246
Delete Adjustment Layer button, 232
Delete Mask button, 196
Gradient Map controls, 252, 253
Hue/Saturation controls, 242, 316
illustrated, 128
Invert button, 193
Levels controls, 236, 260
Linked Smart Object controls, 280, 

281
Live Shape Properties button, 423
Load Selection from Mask button, 

196
Mask Edge option, 195
mask options, 128
Photo Filter controls, 239
Relink to Library Graphic option, 272
settings, 228–232
Update Modified Content option, 272
Vibrance controls, 243, 244

Properties/Print dialog, 476, 477
ProPhoto RGB color space, 8
PSB files, 18, 19, 20
PSD format

in Photoshop feature preservation, 
19

saving raw files in (Camera Raw), 
95–96

selecting, 18

Q
Quick Export, 489
Quick Mask Options dialog, 191
Quick Masks

creating selections via, 191
in reshaping selections, 190
in whitening teeth or eyes, 316

Quick Selection tool, 114, 174–175

R
Radial Filter tool (Camera Raw), 86, 

88–89
RAM, 21
rasterizing

layer effects, 419
layer styles, 419
Smart Objects, 281
type, 400–401

ratings, thumbnail (Bridge), 40
raw files (Camera Raw)

advantages to using, 47–49

copy, opening, 95
JPEG files versus, 47, 49
opening into Camera Raw, 50, 51
opening into Photoshop, 95
previewing, 48
saving, 95
TIFF files versus, 47, 49
See also Camera Raw

Record Stop dialog, 449
Rectangle tool, 115
Rectangular Marquee tool

in creating selections, 170
defined, 114
in deselection, 172
in fixed ratio/dimensions selection, 

170
in frame-shaped selections, 181

Red Eye Removal tool (Camera Raw), 
53, 317

Red Eye tool, 114, 317
Refine Edge dialog

accessing, 183
Decontaminate Colors option, 188, 

189
illustrated, 185
layer mask creation with, 192
Refine Radius tool, 188
refining hair selection with, 186–189
refining selection edges with, 

184–185
Smart Radius option, 186

Refine Mask dialog, 195
Refine menu (Bridge), 32
refocusing. See Blur Gallery
Render filter, 223
rendering intents, 475, 478
Replace Color dialog, 312–313
Replace Contents command, 279
resampling files, 137
reshaping

bounding box, 398
with Content-Aware Move tool, 

330–331
images, 321
layer masks, 193
with Liquify filter, 366–369
selections, 190
shadows, 409
with Warp command, 370

resolution
auto, 140
calculating, 13–14

default values, setting, 16
document, 137–141
image, 137–138
methods of setting, 14
photos (Camera Raw), 56, 58
print output, 14, 16, 138
selecting, 15
Web output, 13, 16

retina displays, zoom and, 101
retouching

by cloning imagery, 326–327
Color Replacement tool, 314–315
eye whitening, 316
Gaussian Blur filter, 324–325
guidelines, 311
Healing Brush tool, 318–320
Liquify filter, 321, 369
Patch tool, 322, 332
Red Eye tool, 317
Replace Color command, 312–313
skin smoothing, 323
Spot Healing Brush tool, 321
Surface Blur filter, 323
teeth whitening, 316

Revert Construction dialog, 368
reverting, to last saved document 

version, 18
Review mode (Bridge), 32, 40
RGB Color mode

channels, 3
defined, 3, 4
for inkjet printing, 473
for Photoshop work, 227

RGB color model, 2, 206, 208
Rotate View tool, 103, 116
rotating

bounding box, 398
clone source overlay, 291
images (Camera Raw), 80
items, 359
layers, 150

Rounded Rectangle tool, 115
ruler guides, 295–296
Ruler tool, 114, 149
rulers, 295, 444

S
Satin layer effect, 411
saturation adjustments

Basic tab (Camera Raw), 65
Color Replacement tool, 314–315
Hue/Saturation, 231
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vibrance, 243–245
in whitening teeth, 316

Save Adobe PDF dialog, 483
Save As dialog, 18, 19, 20, 482
Save As Web dialog, 141
Save dialog, 133
Save Options dialog, 95–96
Save Settings dialog (Camera Raw), 92
Save to Library widget, 210
saving

action sets, 454
adjustment presets, 232
Brush Presets panel brushes, 133
brushes, 303
Camera Raw settings as preset, 92
color settings, 11
custom workspaces, 108–109
document presets, 16
documents, 18–20
files (Camera Raw), 94
files, in PDF format, 483
files, in TIFF format, 486
flattened documents, 168
layer effect settings, 407
layer styles, 417
patterns, 224
presets, 135
previously saved documents, 18
workspaces (Bridge), 38

scaling
based on percentages, 360
clone source overlay, 291
Content-Aware, 360–361
gradients, 411
images (Camera Raw), 80
items, 358
layer effects, 411
layers, 268
of moved pixels, 330
patterns, 411
print output, 478
Smart Objects, 274, 275
styles, 140
type, 390

Scratch Disks preferences, 465
Screen mode menu, 104, 105
screening back type, 399
scripted patterns, 222–226
scrolling, in multiple document 

windows, 103
scrubby sliders, 123
searching for files (Bridge), 44

Select menu
Active Layers command, 426
All command, 169
Color Range command, 178
Deselect command, 172
Deselect Layers command, 396
Focus Area command, 182–183
Grow command, 177
Inverse command, 177
Isolate Layers command, 164
Reselect command, 172
Similar command, 177
Transform Selection command, 358

selection edges
adjusting, 263
feathering, 265
refining, 185–189

selections
adding to via command, 177
in adjustment layers, 228
anchor points on shapes, 427
border, moving, 173
border, showing/hiding, 180, 332
canvas area of a layer, 169
of colors, 178–180
contents, moving, 173
creating paths from, 439
creating via Quick Mask, 191
creating with Color Range command, 

178–180
in defining crop boxes, 147
deleting, 172
deselecting, 172
drag-copying, between files (Move 

tool), 266–267
drag-copying, on same layer, 265
Elliptical Marquee tool, 170, 181
enlarging, 174
expanding, 177
filling, 172
in-focus areas, 182–183
frame-shaped, 181
free-form, 171
hair, 186–189
inverting, 177
Lasso tool, 171
layer-based, 155
loading, 184
loading layer masks as, 196
loading paths as, 442
loading shape layers as, 425
nontransparent areas of layer, 169

pasting into, 264
Polygonal Lasso tool, 171
Quick Selection tool, 174–175
Rectangular Marquee tool, 170, 181
refining edges, 183, 184–185
reselecting, 172
reshaping, 190
saving, 184
shape layer path, 426–427
shrinking, 174
storing as masks, 191
straight-sided, 171
transforming, 358–359
type, 386
vector tool, 171

Settings menu (Camera Raw), 60, 92
shadows

Brightness/Contrast adjustment, 238
clipping, removing (Camera Raw), 64
Color Balance adjustment, 240
Curves adjustment, 246–247
drop (layer effect), 408–409
HDR images, 256
Levels adjustment, 236
pixels in histogram, 235
softening, 345
tinting (Camera Raw), 77

Shake Reduction filter
applying, 349–352
blur trace path, creating/adjusting, 

350–351
blur trace regions, creating, 350
defined, 349
edge noise, reducing, 350
settings, saving, 352
settings, selecting, 349
settings comparison/adjustment in a 

loupe, 351
shape layers

adding shapes to, 429
aligning shapes within, 429
anchor points selection, 427
attributes, changing, 423–425
combining into one layer, 429
creating paths from, 439
creating vector masks from, 430
creating with shape tools, 422
defined, 126
de-isolating, 428
excluding shapes in, 429
intersecting shapes in, 429
isolating, 428
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loading as selection, 425
merging, 166
paths, selecting, 426–427
properties, changing, 423–424
properties, copying, 425
subtracting shapes in, 429
uniting shapes in, 429
warp settings, 370
See also vector objects

Shape Name dialog, 439
Sharpen tool, 115, 352
sharpening

Camera Raw, 48
photos (Camera Raw), 56, 68
Shake Reduction filter, 349–352
Sharpen tool, 115, 352
Smart Sharpen filter, 344–346
Unsharp Mask filter, 347–348

shortcuts
layer mask, 233
tool setting changes, 131
transform, 359
undo, 111
zoom, 101

Single Column Marquee tool, 114, 170
Single Row Marquee tool, 114, 170
Single-Line Composer, 394
16-bit files, 17
skewing items, 359
skin smoothing, 323, 324–325
Slice Select tool, 114
Slice tool, 114
Smart collections (Bridge), 45
Smart Filters

applying, 374
blending options, editing, 375
copying, 375
deleting, 376
editing, 374
example use, 377–378
hiding/showing effects, 375
mask, 376
restacking, 375

Smart Guides
aligning layer content with, 159
in moving or copying layers, 294
transformations with, 358

Smart Objects
applying filters to, 374–381
converting, 283
copies, converting into layer, 279
copying, 277

defined, 272
duplicating, 277
embedded

converting layers in 
Photoshop files to, 272

converting to linked, 283
creating, 272–275
duplicates, creating, 277
duplicates, editing, 277–278
editing, 276–278
opening files as, 273
opening files from Camera 

Raw as, 273
pasting Adobe Illustrator 

art as, 274
placing/dragging files as, 274–275
replacing, 279

importing type as, 385
library-linked, 280
in lieu of merge or flatten, 166
linked

converting to embedded, 283
creating, 280
editing contents of, 281
missing, alert for, 35
missing, getting data on, 282
relinking, 282
replacing, 279
updating, 282
working with, 281–283

listings on Layers panel, filtering, 283
merging, 166
Missing and Changed list, 21
opacity, 377
rasterizing, 281
replacing, 279
thumbnails, 277, 278, 279

Smart Quotes, 385
Smart Sharpen filter, 344–346
Smudge tool, 115
Snap To feature, 296
snapshots

creation of, 201
deleting, 203
document creation from, 204
of history state, 202
naming, 202
as newest history state, 203
options, 201
using, 201–203

Snapshots tab (Camera Raw), 59, 92
soft proofs, 473–475

Solid Color fill layers, 186, 216
Spatter filter, 419
Spin blur filter

blurring control, 334
defined, 333
mask, using, 343
strobe effect, 340
using, 340

Split Toning tab (Camera Raw), 59, 77
Sponge tool, 115
spot colors

channel, putting type in, 402
choosing, 207
for color accuracy, 206
defined, 206
separation into process colors, 207

Spot Healing Brush tool
Content-Aware option, 321, 328
defined, 114
using, 321

Spot Removal tool (Camera Raw), 53, 
90–91

spring-loading tools, 113
sRGB IEC61966-2.1 color space, 8
standard collections (Bridge), 45, 46
Standard screen mode, 104
Startup Scripts preferences (Bridge), 

472
Status bar, 21
Straighten tool (Camera Raw), 53, 55
straightening, 55, 149
strobe-and-flash effect, 340
stroke, shape layer, 424–425
Stroke layer effect, 410
styles. See layer styles
Styles panel

Clear Style button, 416
illustrated, 129
New Style button, 417
saving styles to, 417
uses, 129

Surface Blur filter, 323
SVG file format, 487
swatches, color

creating, 209
current, using, 209
default, restoring, 209
loading, 209
predefined, 129
text, 387
user-defined, 129
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Swatches panel
adding color to, 209
choosing color via, 209
illustrated, 129
Load Swatches command, 209
New Swatch of Foreground Color 

button, 132, 209
Replace Swatches command, 209

Sync Settings preferences, 461, 
495–496

Synchronize dialog (Camera Raw), 94
synchronizing

Camera Raw settings, 94
color settings, 9
lens correction (Camera Raw), 81
presets, 132

T
Targeted Adjustment tool

auto-selecting, 250
Black & White adjustment layer, 250
Curves adjustment layer, 246, 248
Hue/Saturation adjustment, 242

Targeted Adjustment tool (Camera 
Raw), 66–67, 71

Technology Previews preferences, 469
teeth whitening, 316
textures, grain (Camera Raw), 82
Texturizer filter, 381
3D Material Drop tool, 115
3D Material Eyedropper tool, 114
Thumbnail preferences (Bridge), 37, 

471
thumbnails (Bridge)

adding to collections, 46
badge, 50
cycling through, 29
displaying, 29
filtering, 41
full-screen preview of, 30
labeling, 32, 40
last sequence, restoring, 41
multiple, selecting, 29
numbers, 29
previewing, 29–30
quality options, 30
rating, 32, 40
rearranging, 41
removing from collections, 46
removing ratings/labels from, 40
resizing, 36
selecting, 29
sorting, 41

TIFF files
in feature preservation, 18
opening (Bridge), 33
opening in Camera Raw, 50
raw files versus (Camera Raw), 49
saving, 486
saving raw files as (Camera Raw), 

95–96
TIFF Options dialog, 486
Tilt-Shift filter

blurring control, 334
defined, 333
mask, using, 343
in photography, 337
using, 337

Timeline panel, 129
tints

applying to grayscale photo, 77
Black & White adjustment, 250, 252
Gradient Map adjustment, 252–253

tonal adjustments
Basic tab (Camera Raw), 61–65
Black & White adjustment, 250–252
Brightness/Contrast adjustment, 238
Curves adjustment, 246–247
display calibration and, 227
Levels adjustment, 236–237
redistribution (Camera Raw), 48
Tone Curve tab (Camera Raw), 66–67

Tone Curve tab (Camera Raw), 59, 
66–67

Tool Preset picker, 113, 136
tool presets

creating, 132, 136
Crop tool, saving as, 147
default, restoring, 136
defined, 129
setting storage, 303
suggestions for, 136

Tool Presets panel, 129, 303
tool tips, 37, 112
tools

Add Anchor, 115
Art History, 115
Artboard, 362–365
Background Eraser, 115
Blur, 115
Brush, 114, 131, 297–302
Burn, 115
Clone Stamp, 114, 326–327
Color Replacement, 114, 316
Color Sampler, 114

Content-Aware Move, 114, 330–331
Convert Point, 115
Count, 114
Crop, 114, 143–144, 146–148
Custom Shape, 115, 422
Delete Anchor, 115
Direct Selection, 115, 440
Dodge, 115
Ellipse, 115
Elliptical Marquee, 114, 170
Elliptical Marquee tool, 181
Eraser, 115, 308
Eyedropper, 114, 213
Freeform Pen, 115, 434
Gradient, 115, 219, 287
Hand, 102, 116
Healing Brush, 114, 318–320
hidden, selecting, 113
hints, 113
History Brush, 115, 123, 309–310
Horizontal Type, 115, 384
Horizontal Type Mask, 115
Lasso, 114, 171
Line, 115
Magic Eraser, 115
Magic Wand, 114, 176–177
Magnetic Lasso, 114
Mixer Brush, 110, 114, 304–306
Move, 155, 173, 195, 263, 265, 

266–267, 268, 358–359
Note, 114
opacity, 214
Option bar settings, 113
Paint Bucket, 115
Patch, 114, 322, 332
Path Selection, 115, 423, 429, 433
Pattern Stamp, 114
Pen, 115, 436–438
Pencil, 114
Perspective Crop, 114
Polygon, 115
Polygonal Lasso, 114, 171
Quick Selection, 114, 174–175
Rectangle, 115
Rectangular Marquee, 114, 170
Rectangular Marquee tool, 181
Red Eye, 114, 317
Rotate View, 103, 116
Rounded Rectangle, 115
Ruler, 114, 149
selecting, 113
Sharpen, 115, 352
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shortcuts for changing settings, 131
Single Column Marquee, 114, 170
Single Row Marquee, 114, 170
Slice, 114
Slice Select, 114
Smudge, 115
Sponge, 115
Spot Healing Brush, 114, 321
spring-loading, 113
Targeted Adjustment, 242, 246, 248, 

250
3D Material Drop, 115
3D Material Eyedropper, 114
Vertical Type, 115, 384
Vertical Type Mask, 115
Zoom, 101, 103, 116

tools (Camera Raw)
Adjustment Brush tool, 53, 71–76
Crop tool, 53, 54
Graduated Filter tool, 53, 86–87
Radial Filter tool, 88–89
Red Eye Removal tool, 53
Spot Removal tool, 53, 90–91
Straighten tool, 53, 55
Targeted Adjustment tool, 66–67, 71
types of, 53
White Balance tool, 53

Tools menu (Bridge)
Batch Rename command, 43
Cache command, 42
Photoshop submenu

Batch command, 445
Load Files into Photoshop 

Layers command, 268
Merge to HDR Pro command, 254

Tools panel
Change Screen Mode option, 116
cycling through tools on, 113
Edit in Quick Mask Mode option, 116, 

190, 191
Edit in Standard Mode button, 190
illustrated, 114–116
Screen Mode menu, 104, 105
Switch to Design Space option, 116
using, 113
See also tools

Tools preferences, 102, 459–460
touch gestures, 103
TOYO Color Finder, 207
tracking type, 391
transformations

applying, 358–359

Drop Shadow layer effect, 409
with Free Transform command, 

358–359
with Move tool, 358–359
paragraph type, 398
path, 441
selection border, 173
shortcuts, 359
with Smart Guides, 358
type, 390, 398
via Options bar, 359

Transparency & Gamut preferences, 
160, 466

Trim command, 148
TRUMATCH color system, 207
type

aligning, 384, 394
anti-aliasing, 385
attributes, changing, 386
baseline shift, 392
converting, point/paragraph, 390
deleting, 386
editable, 383, 384
editing, 386
editing mode, exiting, 386
embossed leather, 420
fading, 397
font family/style, changing, 387
font size, changing, 390
formatting, 395–397
hyphenation, 394
importing as Smart Object, 385
justifying, 394
kerning, 391
leading, 392
orientation, 392
paragraph, 384, 390, 398
paragraph settings, 394
point, 384, 390
rasterizing, 400–401
recoloring, 387
repositioning, on image, 399
scaling, 390
screening back layers with, 399
selecting, 386
special characters, 393
in spot color channel, 402
tracking, 391
transforming, 390, 398
warp settings, 370

Type preferences, 385, 469

type styles
applying, 395
creating, 395
default, creating and loading, 397
editing, 396
formatting type with, 395–397
in Libraries panel, 271
loading between documents, 397
overrides, clearing, 396

Typekit, 34, 388–389
Typekit.com, 388–389

U
undo shortcuts, 111
Units & Rulers preferences, 16, 467
Unsharp Mask filter, 347–348

V
vector masks

applying to its layer, 196
converting to layer masks, 433
copying, 432
creating by drawing path, 431
creating from existing path, 430
creating from shape layer, 430
creating from type, 432
deleting, 196
density adjustment, 194
disabling or deleting, 432
feather adjustment, 194
function, switching, 433
moving, 432
repositioning, 433
working with, 431–433

vector objects
aligning, 421
anchor points, adding/deleting, 

440–441
creating, 422
defined, 421
points, converting, 440
reshaping, 440–441
saving as custom shape, 439
segments, reshaping, 440
Snap Vector Tools and Transforms to 

Pixel Grid option, 421
Vertical Type Mask tool, 115
Vertical Type tool

in changing font size, 390
creating type with, 384–385
defined, 115
recoloring type with, 387
selecting type with, 386
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Vibrance adjustments, 243–245
View menu

Clear Guides command, 296
Extras command, 294, 358
Lock Guides command, 296
New Guide Layout command, 296
Proof Colors command, 474, 475
Proof Setup command, 218, 474
Rulers command, 295
Show submenu, 159, 180, 294, 295, 

334
Snap command, 295, 296
Snap To submenu, 145, 173, 296

vignettes (Camera Raw)
applying with Effects tab, 83
correcting in Manual tab, 79–81
correcting in Profile tab, 78

W
Warp command, 370
Warp Text dialog, 368
Web output

aligning vector objects for, 421
buttons for, 425
downsampling images for, 141
resolution and dimensions for, 13, 16

white balance (Camera Raw), 60–61
White Balance tool (Camera Raw), 53
white point, calibration, 6
Window menu

Arrange submenu, 99, 100, 102, 262, 
268

Brush Presets command, 303
Channels command, 2
Character command, 386
Extensions submenu, 210
Libraries command, 270
Options command, 110, 113, 130
Workspace submenu, 104

Windows
droplet usability in, 448
exiting Photoshop in, 22
launching Bridge in, 23
launching photoshop in, 1
Save As dialog box, 19

Work Paths, 434, 435
Workflow Options dialog (Camera 

Raw)
Depth menu, 56
Intent options, 56
Open in Photoshop as Smart Objects 

option, 56
Preset menu, 56
presets, 56–57, 58
Resize to Fit menu, 58
settings, choosing, 56–57, 95
Simulate Paper & Ink option, 56
Space menu, 56, 57

working spaces
CMYK, 482
current, assigning, 12
settings, 8

Workspace menu (Options bar), 104, 
108, 109, 110

Workspace preferences, 99, 106, 109, 
457

workspaces
choosing, 104
deleting, 109
non-user-defined, resetting, 109
resetting, 109
saving, 108–109

workspaces (Bridge)
changing, 28
choosing, 28
custom, 38
default, 26
deleting, 38
Essentials, 28
Filmstrip, 28
Light Table, 28
order, changing, 28
predefined, restoring, 38
Preview, 28
resetting, 38
saving, 38

wrinkle removal, 318, 319, 322

Z
zoom, 101–103
Zoom tool

defined, 116
Scrubby Zoom, 101
Zoom All Windows option, 103
zoom level changes with, 101
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